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Preface

SPSS 16.0

SPSS 16.0 is a comprehensive system for analyzing data. SPSS can take data from almost any
type of file and use them to generate tabulated reports, charts and plots of distributions and trends,
descriptive statistics, and complex statistical analyses.

This manual, the SPSS Base 16.0 User s Guide, documents the graphical user interface of
SPSS. Examples using the statistical procedures found in SPSS Base 16.0 are provided in the
Help system, installed with the software. Algorithms used in the statistical procedures are
provided in PDF form and are available from the Help menu.

In addition, beneath the menus and dialog boxes, SPSS uses a command language. Some
extended features of the system can be accessed only via command syntax. (Those features are
not available in the Student Version.) Detailed command syntax reference information is available
in two forms: integrated into the overall Help system and as a separate document in PDF form in
the SPSS 16.0 Command Syntax Reference, also available from the Help menu.

SPSS Options

The following options are available as add-on enhancements to the full (not Student Version)
SPSS Base system:

SPSS Regression Models™ provides techniques for analyzing data that do not fit traditional
linear statistical models. It includes procedures for probit analysis, logistic regression, weight
estimation, two-stage least-squares regression, and general nonlinear regression.

SPSS Advanced Models™ focuses on techniques often used in sophisticated experimental and
biomedical research. It includes procedures for general linear models (GLM), linear mixed
models, generalized linear models (GZLM), generalized estimating equations (GEE), variance
components analysis, loglinear analysis, actuarial life tables, Kaplan-Meier survival analysis, and
basic and extended Cox regression.

SPSS Tables™ creates a variety of presentation-quality tabular reports, including complex
stub-and-banner tables and displays of multiple-response data.

SPSS Trends™ performs comprehensive forecasting and time series analyses with multiple
curve-fitting models, smoothing models, and methods for estimating autoregressive functions.

SPSS Categories® performs optimal scaling procedures, including correspondence analysis.

SPSS Conjoint™ provides a realistic way to measure how individual product attributes affect
consumer and citizen preferences. With SPSS Conjoint, you can easily measure the trade-off
effect of each product attribute in the context of a set of product attributes—as consumers do
when making purchasing decisions.



SPSS Exact Tests™ calculates exact p values for statistical tests when small or very unevenly
distributed samples could make the usual tests inaccurate.

SPSS Missing Value Analysis™ describes patterns of missing data, estimates means and other
statistics, and imputes values for missing observations.

SPSS Maps™ turns your geographically distributed data into high-quality maps with symbols,
colors, bar charts, pie charts, and combinations of themes to present not only what is happening
but where it is happening.

SPSS Complex Samples™ allows survey, market, health, and public opinion researchers, as well
as social scientists who use sample survey methodology, to incorporate their complex sample
designs into data analysis.

SPSS Classification Trees™ creates a tree-based classification model. It classifies cases into groups
or predicts values of a dependent (target) variable based on values of independent (predictor)
variables. The procedure provides validation tools for exploratory and confirmatory classification
analysis.

SPSS Data Preparation™ provides a quick visual snapshot of your data. It provides the ability to
apply validation rules that identify invalid data values. You can create rules that flag out-of-range
values, missing values, or blank values. You can also save variables that record individual rule
violations and the total number of rule violations per case. A limited set of predefined rules that
you can copy or modify is provided.

Amos™ (analysis of moment structures) uses structural equation modeling to confirm and explain
conceptual models that involve attitudes, perceptions, and other factors that drive behavior.

The SPSS family of products also includes applications for data entry, text analysis, classification,
neural networks, and predictive enterprise services.

Installation

To install the SPSS Base system, run the License Authorization Wizard using the authorization
code that you received from SPSS Inc. For more information, see the installation instructions
supplied with the SPSS Base system.

Compatibility

SPSS is designed to run on many computer systems. See the installation instructions that came
with your system for specific information on minimum and recommended requirements.

Serial Numbers

Your serial number is your identification number with SPSS Inc. You will need this serial number
when you contact SPSS Inc. for information regarding support, payment, or an upgraded system.
The serial number was provided with your Base system.
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Customer Service

If you have any questions concerning your shipment or account, contact your local office, listed
on the SPSS Web site at http.//www.spss.com/worldwide. Please have your serial number ready
for identification.

Training Seminars

SPSS Inc. provides both public and onsite training seminars. All seminars feature
hands-on workshops. Seminars will be offered in major cities on a regular basis. For more
information on these seminars, contact your local office, listed on the SPSS Web site at
http://www.spss.com/worldwide.

Technical Support

The services of SPSS Technical Support are available to maintenance customers. Customers
may contact Technical Support for assistance in using SPSS or for installation help for one
of the supported hardware environments. To reach Technical Support, see the SPSS Web
site at http://www.spss.com, or contact your local office, listed on the SPSS Web site at
http://www.spss.com/worldwide. Be prepared to identify yourself, your organization, and the
serial number of your system.

Additional Publications

Additional copies of product manuals may be purchased directly from SPSS Inc. Visit the SPSS
Web Store at http://www.spss.com/estore, or contact your local SPSS office, listed on the SPSS
Web site at http://www.spss.com/worldwide. For telephone orders in the United States and
Canada, call SPSS Inc. at 800-543-2185. For telephone orders outside of North America, contact
your local office, listed on the SPSS Web site.

The SPSS Statistical Procedures Companion, by Marija Norusis, has been published by
Prentice Hall. A new version of this book, updated for SPSS 16.0, is planned. The SPSS
Advanced Statistical Procedures Companion, also based on SPSS 16.0, is forthcoming. The
SPSS Guide to Data Analysis for SPSS 16.0 is also in development. Announcements of
publications available exclusively through Prentice Hall will be available on the SPSS Web site at
http://www.spss.com/estore (select your home country, and then click Books).

Tell Us Your Thoughts

Your comments are important. Please let us know about your experiences with SPSS products. We
especially like to hear about new and interesting applications using the SPSS Base system. Please
send e-mail to suggest@spss.com or write to SPSS Inc., Attn.: Director of Product Planning, 233
South Wacker Drive, 11th Floor, Chicago, IL 60606-6412.

About This Manual

This manual documents the graphical user interface for the procedures included in the SPSS
Base system. Illustrations of dialog boxes are taken from SPSS. Detailed information about the
command syntax for features in the SPSS Base system is available in two forms: integrated into
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the overall Help system and as a separate document in PDF form in the SPSS 16.0 Command
Syntax Reference, available from the Help menu.

Contacting SPSS

If you would like to be on our mailing list, contact one of our offices, listed on our Web site
at http://www.spss.com/worldwide.
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Chapter

Overview

SPSS provides a powerful statistical-analysis and data-management system in a graphical
environment, using descriptive menus and simple dialog boxes to do most of the work for you.
Most tasks can be accomplished simply by pointing and clicking the mouse.

In addition to the simple point-and-click interface for statistical analysis, SPSS provides:

Data Editor. The Data Editor is a versatile spreadsheet-like system for defining, entering, editing,
and displaying data.

Viewer. The Viewer makes it easy to browse your results, selectively show and hide output,
change the display order results, and move presentation-quality tables and charts to and from
other applications.

Multidimensional pivot tables. Your results come alive with multidimensional pivot tables. Explore
your tables by rearranging rows, columns, and layers. Uncover important findings that can get
lost in standard reports. Compare groups easily by splitting your table so that only one group is
displayed at a time.

High-resolution graphics. High-resolution, full-color pie charts, bar charts, histograms, scatterplots,
3-D graphics, and more are included as standard features.

Database access. Retrieve information from databases by using the Database Wizard instead of
complicated SQL queries.

Data transformations. Transformation features help get your data ready for analysis. You can easily
subset data; combine categories; add, aggregate, merge, split, and transpose files; and more.

Online Help. Detailed tutorials provide a comprehensive overview; context-sensitive Help topics in
dialog boxes guide you through specific tasks; pop-up definitions in pivot table results explain
statistical terms; the Statistics Coach helps you find the procedures that you need; Case Studies
provide hands-on examples of how to use statistical procedures and interpret the results.

Command language. Although most tasks can be accomplished with simple point-and-click
gestures, SPSS also provides a powerful command language that allows you to save and automate
many common tasks. The command language also provides some functionality that is not found
in the menus and dialog boxes.

Complete command syntax documentation is integrated into the overall Help system and is
available as a separate PDF document, Command Syntax Reference, which is also available
from the Help menu.
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What's New in Version 16.0?

User interface enhancements. Enhancements to the point-and-click interface include:

m  All dialog boxes are now resizable. The ability to make a dialog box wider makes variable
lists wider so that you can see more of the variable names and/or descriptive labels. The
ability to make a dialog box longer makes variable lists longer so that you can see more
variables without scrolling.

Drag-and-drop variable selection is now supported in all dialog boxes.

Variable list display order and display characteristics can be changed on the fly in all dialog
boxes. Change the sort order (alphabetic, file order, measurement level) and/or switch between
display of variable names or variable labels whenever you want. For more information, see
Variable Names and Variable Labels in Dialog Box Lists on p. 6.

Data and output management. Data and output management enhancements include:
m Read and write Excel 2007 files.

m  Choose between working with multiple datasets or one dataset at a time. For more
information, see General Options in Chapter 45 on p. 454.

m  Search and replace information in Viewer documents, including hidden items and layers in
multidimensional pivot tables. For more information, see Finding and Replacing Information
in the Viewer in Chapter 10 on p. 208.

B Assign missing values and value labels to any string variable, regardless of the defined string
width (previously limited to strings with a defined width of 8 or less bytes).

New character-based string functions.

Output Management System (OMS) support for Viewer file format (.spv) and VML-format
charts and image maps with pop-up chart information for HTML documents. For more
information, see Output Management System in Chapter 48 on p. 484.

m Customize Variable View in the Data Editor. Change the display order of the attribute
columns, and control which attribute columns are displayed. For more information, see
Customizing Variable View in Chapter 5 on p. 84.

m  Sort variables in the active dataset alphabetically or by attribute (dictionary) values. For more
information, see Sort Variables in Chapter 9 on p. 168.

m  Spell check variable labels and value labels in Variable View. For more information, see Spell
Checking Variable and Value Labels in Chapter 5 on p. 85.

m  Change basic variable type (string, numeric), change the defined width of string variables, and
automatically set the width of string variables to the longest observed value for each variable.

m  Read and write Unicode data and syntax files. For more information, see General Options
in Chapter 45 on p. 454.

m  Control the default directory location to look for and save files. For more information, see File
Locations Options in Chapter 45 on p. 466.

Performance. For computers with multiple processors or processors with multiple cores,
multithreading for faster performance is now available for some procedures.
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Statistical enhancements. Statistical enhancements include:

Partial Least Squares (PLS). A predictive technique that is an alternative to ordinary least
squares (OLS) regression, canonical correlation, or structural equation modeling, and it is
particularly useful when predictor variables are highly correlated or when the number of

predictors exceeds the number of cases. For more information, see Partial Least Squares

Regression in Chapter 29 on p. 342.

Multilayer perceptron (MLP). The MLP procedure fits a particular kind of neural network
called a multilayer perceptron. The multilayer perceptron uses a feed-forward architecture
and can have multiple hidden layers. The multilayer perceptron is very flexible in the types of
models it can fit. It is one of the most commonly used neural network architectures. This
procedure is available in the new Neural Networks option.

Radial basis function (RBF). A Radial basis function (RBF) network is a feed-forward,
supervised learning network with only one hidden layer, called the radial basis function layer.
Like the multilayer perceptron (MLP) network, the RBF network can do both prediction and
classification. It can be much faster than MLP, however it is not as flexible in the types of
models it can fit. This procedure is available in the new Neural Networks option.

Generalized Linear Models supports numerous new features, including ordinal multinomial
and Tweedie distributions, maximum likelihood estimation of the negative binomial ancillary
parameter, and likelihood-ratio statistics. This procedure is available in the Advanced Models
option.

Cox Regression now provides the ability to export model information to an XML (PMML)
file. This procedure is available in the Advanced Models option.

Complex Samples Cox Regression. Apply Cox proportional hazards regression to analysis
of survival times—that is, the length of time before the occurrence of an event for samples
drawn by complex sampling methods. This procedure supports continuous and categorical
predictors, which can be time-dependent. This procedure provides an easy way of considering
differences in subgroups as well as analyzing effects of a set of predictors. The procedure
estimates variances by taking into account the sample design used to select the sample,
including equal probability and probability proportional to size (PPS) methods and with
replacement (WR) and without replacement (WOR) sampling procedures. This procedure is
available in the Complex Samples option.

Programmability extension. Programmability extension enhancements include:

R-Plugin. Combine the power of SPSS with the ability to write your own statistical routines
with R. This plug-in is available only as a download from www.spss.com/devcentral
(http://www.spss.com/devcentral).

Nested Begin Program-End Program command structures.

Ability to create and manage multiple datasets.

Command syntax. For a complete list of command syntax additions and changes, see the Release
History section of the Introduction chapter in the Command Syntax Reference (available on the
Help menu).


http://www.spss.com/devcentral
http://www.spss.com/devcentral
http://www.spss.com/devcentral
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Features No Longer Supported

B There is no longer a separate chart editor for “interactive” charts. Charts created from the
legacy “interactive” chart dialog boxes and from IGRAPH command syntax are created in the
same format as all other charts and edited in the same chart editor.

m  Some features provided in the legacy “interactive” chart dialog boxes and IGRAPH command
syntax are no longer available.

The Draft Viewer is no longer available.

You cannot open Viewer files created in previous versions of SPSS (.spo files) in SPSS 16.0.
For Windows operating systems, the installation CD includes a Legacy Viewer that you can
install to view and edit Viewer files created in previous releases.

m  The Maps option is no longer available.

® Dialog box interfaces for the legacy procedures in the Trends and Tables options are no
longer available. For Trends, this includes the following commands: AREG, ARIMA, and
EXSMOOTH. For Tables, this includes the TABLES command. If you have a license for either of
these options that includes the legacy procedures, command syntax for these commands is
still supported.

Windows

There are a number of different types of windows in SPSS:

Data Editor. The Data Editor displays the contents of the data file. You can create new data files or
modify existing data files with the Data Editor. If you have more than one data file open, there is a
separate Data Editor window for each data file.

Viewer. All statistical results, tables, and charts are displayed in the Viewer. You can edit the
output and save it for later use. A Viewer window opens automatically the first time you run
a procedure that generates output.

Pivot Table Editor. Output that is displayed in pivot tables can be modified in many ways with
the Pivot Table Editor. You can edit text, swap data in rows and columns, add color, create
multidimensional tables, and selectively hide and show results.

Chart Editor. You can modify high-resolution charts and plots in chart windows. You can change
the colors, select different type fonts or sizes, switch the horizontal and vertical axes, rotate 3-D
scatterplots, and even change the chart type.

Text Output Editor. Text output that is not displayed in pivot tables can be modified with the Text
Output Editor. You can edit the output and change font characteristics (type, style, color, size).

Syntax Editor. You can paste your dialog box choices into a syntax window, where your selections
appear in the form of command syntax. You can then edit the command syntax to use special
features that are not available through dialog boxes. You can save these commands in a file for
use in subsequent sessions.
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Figure 1-1
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Designated Window versus Active Window

If you have more than one open Viewer window, output is routed to the designated Viewer
window. If you have more than one open Syntax Editor window, command syntax is pasted into
the designated Syntax Editor window. The designated windows are indicated by a plus sign in the
icon in the title bar. You can change the designated windows at any time.

The designated window should not be confused with the active window, which is the currently
selected window. If you have overlapping windows, the active window appears in the foreground.
If you open a window, that window automatically becomes the active window and the designated
window.

Changing the Designated Window

>

>

>

Make the window that you want to designate the active window (click anywhere in the window).
Click the Designate Window button on the toolbar (the plus sign icon).

or

From the menus choose:

Utilities
Designate Window

Note: For Data Editor windows, the active Data Editor window determines the dataset that is used
in subsequent calculations or analyses. There is no “designated” Data Editor window. For more
information, see Basic Handling of Multiple Data Sources in Chapter 6 on p. 93.
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Status Bar

The status bar at the bottom of each SPSS window provides the following information:

Command status. For each procedure or command that you run, a case counter indicates the
number of cases processed so far. For statistical procedures that require iterative processing, the
number of iterations is displayed.

Filter status. If you have selected a random sample or a subset of cases for analysis, the message
Filter on indicates that some type of case filtering is currently in effect and not all cases in the
data file are included in the analysis.

Weight status. The message Weight on indicates that a weight variable is being used to weight
cases for analysis.

Split File status. The message Split File on indicates that the data file has been split into separate
groups for analysis, based on the values of one or more grouping variables.

Dialog Boxes

Most menu selections open dialog boxes. You use dialog boxes to select variables and options
for analysis.

Dialog boxes for statistical procedures and charts typically have two basic components:

Source variable list. A list of variables in the active dataset. Only variable types that are allowed
by the selected procedure are displayed in the source list. Use of short string and long string
variables is restricted in many procedures.

Target variable list(s). One or more lists indicating the variables that you have chosen for the
analysis, such as dependent and independent variable lists.

Variable Names and Variable Labels in Dialog Box Lists

You can display either variable names or variable labels in dialog box lists, and you can control
the sort order of variables in source variable lists.

m  To control the default display attributes of variables in source lists, choose Options on the Edit
menu. For more information, see General Options in Chapter 45 on p. 454.

m  To change the source variable list display attributes within a dialog box, right-click on any
variable in the source list and select the display attributes from the context menu. You can
display either variable names or variable labels (names are displayed for any variables
without defined labels), and you can sort the source list by file order, alphabetical order, or
measurement level. For more information on measurement level, see Data Type, Measurement
Level, and Variable List Icons on p. 8.
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Figure 1-2

Variable labels displayed in a dialog box
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Resizing Dialog Boxes

You can resize dialog boxes just like windows, by clicking and dragging the outside borders or
corners. For example, if you make the dialog box wider, the variable lists will also be wider.

Figure 1-3
Resized dialog box
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Dialog Box Controls

There are five standard controls in most dialog boxes:

OK. Runs the procedure. After you select your variables and choose any additional specifications,
click OK to run the procedure and close the dialog box.

Paste. Generates command syntax from the dialog box selections and pastes the syntax into a
syntax window. You can then customize the commands with additional features that are not
available from dialog boxes.
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Reset. Deselects any variables in the selected variable list(s) and resets all specifications in the
dialog box and any subdialog boxes to the default state.

Cancel. Cancels any changes that were made in the dialog box settings since the last time it was
opened and closes the dialog box. Within a session, dialog box settings are persistent. A dialog
box retains your last set of specifications until you override them.

Help. Provides context-sensitive Help. This control takes you to a Help window that contains
information about the current dialog box.

Selecting Variables

To select a single variable, simply select it in the source variable list and drag and drop it into the
target variable list. You can also use arrow button to move variables from the source list to the
target lists. If there is only one target variable list, you can double-click individual variables to
move them from the source list to the target list.

You can also select multiple variables:

m  To select multiple variables that are grouped together in the variable list, click the first variable
and then Shift-click the last variable in the group.

m  To select multiple variables that are not grouped together in the variable list, click the first
variable, then Ctrl-click the next variable, and so on (Macintosh: Command-click).

Data Type, Measurement Level, and Variable List Icons

The icons that are displayed next to variables in dialog box lists provide information about the
variable type and measurement level.

Measurement Data Type
Level

Numeric String Date

Scale n/a

| &
Ordinal d:i d:g
&>

Nominal

®  For more information on measurement level, see Variable Measurement Level on p. 75.

®  For more information on numeric, string, date, and time data types, see Variable Type on p. 76.

Getting Information about Variables in Dialog Boxes

» Right-click a variable in the source or target variable list.

» Choose Variable Information.
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Figure 1-4
Variable information
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Basic Steps in Data Analysis

Analyzing data with SPSS is easy. All you have to do is:

Get your data into SPSS. You can open a previously saved SPSS data file, you can read a
spreadsheet, database, or text data file, or you can enter your data directly in the Data Editor.

Select a procedure. Select a procedure from the menus to calculate statistics or to create a chart.

Select the variables for the analysis. The variables in the data file are displayed in a dialog box for
the procedure.

Run the procedure and look at the results. Results are displayed in the Viewer.

Statistics Coach

If you are unfamiliar with SPSS or with the available statistical procedures, the Statistics Coach
can help you get started by prompting you with simple questions, nontechnical language, and
visual examples that help you select the basic statistical and charting features that are best
suited for your data.

To use the Statistics Coach, from the menus in any SPSS window choose:

Help
Statistics Coach

The Statistics Coach covers only a selected subset of procedures in the Base system. It is designed
to provide general assistance for many of the basic, commonly used statistical techniques.
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Finding Out More

For a comprehensive overview of the basics, see the online tutorial. From any SPSS menu choose:

Help
Tutorial



Chapter

Getting Help

Help is provided in many different forms:

Help menu. The Help menu in most SPSS windows provides access to the main Help system,
plus tutorials and technical reference material.

Topies. Provides access to the Contents, Index, and Search tabs, which you can use to find
specific Help topics.

Tutorial. Illustrated, step-by-step instructions on how to use many of the basic features in
SPSS. You don’t have to view the whole tutorial from start to finish. You can choose the
topics you want to view, skip around and view topics in any order, and use the index or table
of contents to find specific topics.

Case Studies. Hands-on examples of how to create various types of statistical analyses and
how to interpret the results. The sample data files used in the examples are also provided so
that you can work through the examples to see exactly how the results were produced. You
can choose the specific procedure(s) that you want to learn about from the table of contents
or search for relevant topics in the index.

Statistics Coach. A wizard-like approach to guide you through the process of finding the
procedure that you want to use. After you make a series of selections, the Statistics Coach
opens the dialog box for the statistical, reporting, or charting procedure that meets your
selected criteria. The Statistics Coach provides access to most statistical and reporting
procedures in the Base system and many charting procedures.

Command Syntax Reference. Detailed command syntax reference information is available in
two forms: integrated into the overall Help system and as a separate document in PDF form in
the SPSS Command Syntax Reference, available from the Help menu.

Statistical Algorithms. The algorithms used for most statistical procedures are available in two
forms: integrated into the overall Help system and as a separate document in PDF form in
SPSS Algorithms, available on the manuals CD. For links to specific algorithms in the Help
system, choose Algorithms from the Help menu.

Context-sensitive Help. In many places in the user interface, you can get context-sensitive Help.

Dialog box Help buttons. Most dialog boxes have a Help button that takes you directly to a
Help topic for that dialog box. The Help topic provides general information and links to
related topics.

1
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m Pivot table context menu Help. Right-click on terms in an activated pivot table in the Viewer
and choose What's This? from the context menu to display definitions of the terms.

®  Command syntax. In a command syntax window, position the cursor anywhere within a syntax
block for a command and press F1 on the keyboard. A complete command syntax chart for
that command will be displayed. Complete command syntax documentation is available from
the links in the list of related topics and from the Help Contents tab.

Other Resources

Technical Support Web site. Answers to many common problems can be found at
http://support.spss.com. (The Technical Support Web site requires a login ID and password.
Information on how to obtain an ID and password is provided at the URL listed above.)

SPSS Developer Central. Developer Central has resources for all levels of SPSS users and SPSS
application developers. Download utilities, graphics examples, new statistical modules, and
articles on SPSS technology. Use the forums to interact with SPSS and the SPSS user community.
Visit SPSS Developer Central at http.//www.spss.com/devcentral.

Getting Help on Output Terms

>

>

>

To see a definition for a term in pivot table output in the Viewer:
Double-click the pivot table to activate it.
Right-click on the term that you want explained.

Choose What's This? from the context menu.

A definition of the term is displayed in a pop-up window.

Figure 2-1

Activated pivot table glossary Help with right mouse button

~
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Files

Data files come in a wide variety of formats, and this software is designed to handle many of
them, including:

Spreadsheets created with Excel and Lotus

Database tables from many database sources, including Oracle, SQLServer, Access, dBASE,
and others

Tab-delimited and other types of simple text files

Data files in SPSS format created on other operating systems
SYSTAT data files

SAS data files

Stata data files

Opening Data Files

In addition to files saved in SPSS format, you can open Excel, SAS, Stata, tab-delimited, and other
files without converting the files to an intermediate format or entering data definition information.

Opening a data file makes it the active dataset. If you already have one or more open data
files, they remain open and available for subsequent use in the session. Clicking anywhere
in the Data Editor window for an open data file will make it the active dataset. For more
information, see Working with Multiple Data Sources in Chapter 6 on p. 93.

In distributed analysis mode using a remote server to process commands and run procedures,
the available data files, folders, and drives are dependent on what is available on or from the
remote server. The current server name is indicated at the top of the dialog box. You will
not have access to data files on your local computer unless you specify the drive as a shared
device and the folders containing your data files as shared folders. For more information, see
Distributed Analysis Mode in Chapter 4 on p. 65.

To Open Data Files

» From the menus choose:
File
Open

Data...

» In the Open Data dialog box, select the file that you want to open.

» Click Open.

13
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Optionally, you can:

B Automatically set the width of each string variable to the longest observed value for that
variable using Minimize string widths based on observed values. This is particularly useful
when reading code page data files in Unicode mode. For more information, see General
Options in Chapter 45 on p. 454.

m Read variable names from the first row of spreadsheet files.
Specify a range of cells to read from spreadsheet files.

Specify a worksheet within an Excel file to read (Excel 95 or later).

For information on reading data from databases, see Reading Database Files on p. 16. For
information on reading data from text data files, see Text Wizard on p. 29.

Data File Types

SPSS. Opens data files saved in SPSS format and also the DOS product SPSS/PC+.
SPSS/PC+. Opens SPSS/PC+ data files.
SYSTAT. Opens SYSTAT data files.

SPSS Portable. Opens data files saved in portable format. Saving a file in portable format takes
considerably longer than saving the file in SPSS format.

Excel. Opens Excel files.
Lotus 1-2-3. Opens data files saved in 1-2-3 format for release 3.0, 2.0, or 1A of Lotus.

SYLK. Opens data files saved in SYLK (symbolic link) format, a format used by some spreadsheet
applications.

dBASE. Opens dBASE-format files for either dBASE IV, dBASE III or III PLUS, or dBASE II.
Each case is a record. Variable and value labels and missing-value specifications are lost when
you save a file in this format.

SAS. SAS versions 6-9 and SAS transport files.

Stata. Stata versions 4-8.

Opening File Options

Read variable names. For spreadsheets, you can read variable names from the first row of the file
or the first row of the defined range. The values are converted as necessary to create valid variable
names, including converting spaces to underscores.

Worksheet. Excel 95 or later files can contain multiple worksheets. By default, the Data Editor
reads the first worksheet. To read a different worksheet, select the worksheet from the drop-down
list.

Range. For spreadsheet data files, you can also read a range of cells. Use the same method for
specifying cell ranges as you would with the spreadsheet application.
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Reading Excel 95 or Later Files

The following rules apply to reading Excel 95 or later files:

Data type and width. Each column is a variable. The data type and width for each variable are
determined by the data type and width in the Excel file. If the column contains more than one
data type (for example, date and numeric), the data type is set to string, and all values are read
as valid string values.

Blank cells. For numeric variables, blank cells are converted to the system-missing value,
indicated by a period. For string variables, a blank is a valid string value, and blank cells are
treated as valid string values.

Variable names. If you read the first row of the Excel file (or the first row of the specified range) as
variable names, values that don’t conform to variable naming rules are converted to valid variable
names, and the original names are used as variable labels. If you do not read variable names from
the Excel file, default variable names are assigned.

Reading Older Excel Files and Other Spreadsheets

The following rules apply to reading Excel files prior to Excel 95 and other spreadsheet data:

Data type and width. The data type and width for each variable are determined by the column
width and data type of the first data cell in the column. Values of other types are converted to the
system-missing value. If the first data cell in the column is blank, the global default data type
for the spreadsheet (usually numeric) is used.

Blank cells. For numeric variables, blank cells are converted to the system-missing value,
indicated by a period. For string variables, a blank is a valid string value, and blank cells are
treated as valid string values.

Variable names. If you do not read variable names from the spreadsheet, the column letters (4,
B, C, ...) are used for variable names for Excel and Lotus files. For SYLK files and Excel files
saved in R1C1 display format, the software uses the column number preceded by the letter C
for variable names (ClI, C2, C3, ...).

Reading dBASE Files

Database files are logically very similar to SPSS-format data files. The following general rules
apply to dBASE files:

m Field names are converted to valid variable names.
®  Colons used in dBASE field names are translated to underscores.

m  Records marked for deletion but not actually purged are included. The software creates a new
string variable, DR, which contains an asterisk for cases marked for deletion.
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Reading Stata Files

The following general rules apply to Stata data files:

m  Variable names. Stata variable names are converted to SPSS variable names in case-sensitive
form. Stata variable names that are identical except for case are converted to valid variable
names by appending an underscore and a sequential letter ( 4, B, C, ..., Z, AA, AB, ...,
etc.).

m Variable labels. Stata variable labels are converted to SPSS variable labels.

m  Value labels. Stata value labels are converted to SPSS value labels, except for Stata value
labels assigned to “extended” missing values.

Missing values. Stata “extended” missing values are converted to system-missing values.

Date conversion. Stata date format values are converted to SPSS DATE format (d-m-y) values.
Stata “time-series” date format values (weeks, months, quarters, etc.) are converted to simple
numeric (F) format, preserving the original, internal integer value, which is the number of
weeks, months, quarters, etc., since the start of 1960.

Reading Database Files

You can read data from any database format for which you have a database driver. In local analysis
mode, the necessary drivers must be installed on your local computer. In distributed analysis
mode (available with SPSS Server), the drivers must be installed on the remote server. For more
information, see Distributed Analysis Mode in Chapter 4 on p. 65.

To Read Database Files

» From the menus choose:
File
Open Database
New Query...

» Select the data source.

» If necessary (depending on the data source), select the database file and/or enter a login name,
password, and other information.

» Select the table(s) and fields. For OLE DB data sources (available only on Windows operating
systems), you can only select one table.

» Specify any relationships between your tables.

» Optionally:
m  Specify any selection criteria for your data.
®  Add a prompt for user input to create a parameter query.

m  Save your constructed query before running it.
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To Edit Saved Database Queries

» From the menus choose:
File
Open Database
Edit Query...

» Select the query file (*.spqg) that you want to edit.

» Follow the instructions for creating a new query.

To Read Database Files with Saved Queries

» From the menus choose:
File
Open Database
Run Query...

» Select the query file (*.spq) that you want to run.
» If necessary (depending on the database file), enter a login name and password.

» If the query has an embedded prompt, enter other information if necessary (for example, the
quarter for which you want to retrieve sales figures).

Selecting a Data Source

Use the first screen of the Database Wizard to select the type of data source to read.

ODBC Data Sources

If you do not have any ODBC data sources configured, or if you want to add a new data source,
click Add ODBC Data Source.

B On Linux operating systems, this button is not available. ODBC data sources are specified in
odbc.ini, and the ODBCINI environment variables must be set to the location of that file. For
more information, see the documentation for your database drivers.

m In distributed analysis mode (available with SPSS Server), this button is not available. To add
data sources in distributed analysis mode, see your system administrator.

An ODBC data source consists of two essential pieces of information: the driver that will be used
to access the data and the location of the database you want to access. To specify data sources,
you must have the appropriate drivers installed. For local analysis mode, you can install drivers
for a variety of database formats from the SPSS installation CD.
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Figure 3-1
Database Wizard

ﬁ Database Wizard

Welcome to the Database Wizard!

Thiz wizard will help yvou get data from a non-SP5S data source.

You can choose the data source, specify which cases are retrieved, aggregste and sart the data befare retrieval, and specify variable
natmes and properties here. Some festures are available only when connected to SPSS Server.

From wehich data sourcels) would you like to retrieve data?

ODBEC Data Sources

'E_a dEASE Files
@3 Excel Files
@3 MZ Access Databasze

| Add ODBC Data Source... |

[ cancet J[_ree ]

OLE DB Data Sources

To access OLE DB data sources (available only on Microsoft Windows operating systems),
you must have the following items installed:

®m . NET framework
® Dimensions Data Model and OLE DB Access

Versions of these components that are compatible with this release can be installed from the
installation CD and are available on the AutoPlay menu.

m  Table joins are not available for OLE DB data sources. You can read only one table at a time.

B You can add OLE DB data sources only in local analysis mode. To add OLE DB data sources
in distributed analysis mode on a Windows server, consult your system administrator.

®m In distributed analysis mode (available with SPSS Server), OLE DB data sources are available
only on Windows servers, and both .NET and the Dimensions Data Model and OLE DB
Access must be installed on the server.
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Figure 3-2
Database Wizard with access to OLE DB data sources

Database Wizard

Welcome to the Database Wizard!

Thig wizard will help you get data from a non-SPSS data source.

You cat choose the data source, specify which cazes are retieved, aggregate and sort the data befaore retieval,
and specify varable names and properties here. Some features are available only when connected to SPSS Server.

From which data source(z) would you like to retrieve data?

OLE DB Data Sources ODBC Data Sources
Demo Access databaze % dBASE Files
SOL survey data E{a Encel Files
Banois
% M5 Access Databaze
Add OLE DB Data Source. .. Add ODBC Data Source... ]

[ Cancel ] [ Help

To add an OLE DB data source:
Click Add OLE DB Data Source.
In Data Link Properties, click the Provider tab and select the OLE DB provider.

Click Next or click the Connection tab.

vV v v Vv

Select the database by entering the directory location and database name or by clicking the button
to browse to a database. (A user name and password may also be required.)

» Click OK after entering all necessary information. (You can make sure the specified database is
available by clicking the Test Connection button.)

» Enter a name for the database connection information. (This name will be displayed in the list
of available OLE DB data sources.)

Figure 3-3
Save OLE DB Connection Information As dialog box

Save OLE DB Connection Information As

Mame | SOL survey data

Caticel

» Click OK.
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This takes you back to the first screen of the Database Wizard, where you can select the saved
name from the list of OLE DB data sources and continue to the next step of the wizard.

Deleting OLE DB Data Sources

To delete data source names from the list of OLE DB data sources, delete the UDL file with the
name of the data source in:

[drive]:\Documents and Settings\[user login]\Local Settings\Application Data\SPSS\UDL

Selecting Data Fields

The Select Data step controls which tables and fields are read. Database fields (columns) are
read as variables.

If a table has any field(s) selected, all of its fields will be visible in the following Database
Wizard windows, but only fields that are selected in this step will be imported as variables. This
enables you to create table joins and to specify criteria by using fields that you are not importing.

Figure 3-4
Database Wizard, selecting data

&7 Database Wizard

Select Data

Select the fields wou want to retrieve. Then click the arrow button or drag the fields to the Retrieve Fields list.

Tip: Selecting & table selects all of its fields.

Available Tables: Retriere Fields In This Crder:
E% demo = dema: I |~
----- % I demao: AGE
""" % AGE demao: MARITAL +
----- B mapmaL k2., demo: ADDRESS
""" 2, ADDRESS B tema: INCOME
""" 2. mcowe # 2 demo: INCCAT 2 e
""" % IHCCAT B demo: CAR
% Eizcm B demo: CARCAT
_____ % D % demo: ED
..... S mupLov B K2, demo; EMPLOY |
_____ 8 perre B, dema: RETIRE
..... B pypcaT 2. demo: EMPCAT
..... B cenper k2, demo: GENDER
..... 8 pesipE k2, demo: RESIDE
..... B \wRELESS 2., demo WIRELESS
..... % MULTLIME % demo: MULTLIME
----- B vore = B, dema: VOICE =
= hd = i

[] 5ot figld names ~ Showe Tables | |wiews [ |Synonyms [ ] Systemtables

| sgeck || med = || Finsh || concel || Hep |

Displaying field names. To list the fields in a table, click the plus sign (+) to the left of a table name.
To hide the fields, click the minus sign (-) to the left of a table name.
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To add a field. Double-click any field in the Available Tables list, or drag it to the Retrieve Fields In
This Order list. Fields can be reordered by dragging and dropping them within the fields list.

To remove a field. Double-click any field in the Retrieve Fields In This Order list, or drag it to the
Available Tables list.

Sort field names. If this check box is selected, the Database Wizard will display your available
fields in alphabetical order.

By default, the list of available tables displays only standard database tables. You can control
the type of items that are displayed in the list:

m Tables. Standard database tables.

m  Views. Views are virtual or dynamic “tables” defined by queries. These can include joins of
multiple tables and/or fields derived from calculations based on the values of other fields.

Synonyms. A synonym is an alias for a table or view, typically defined in a query.

System tables. System tables define database properties. In some cases, standard database
tables may be classified as system tables and will only be displayed if you select this option.
Access to real system tables is often restricted to database administrators.

Note: For OLE DB data sources (available only on Windows operating systems), you can select
fields only from a single table. Multiple table joins are not supported for OLE DB data sources.

Creating a Relationship between Tables

The Specify Relationships step allows you to define the relationships between the tables for ODBC
data sources. If fields from more than one table are selected, you must define at least one join.
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Figure 3-5
Database Wizard, specifying relationships
ﬁDatahase Wizard
Specify Relationships
In arder to retrieve data from multiple tables, you must specify how ta join them. Ta indicate a jain, first select the type of join that you
want. Then drag a field from one table to the corresponding field in other table. Alternatively, you can select the two fields and
press the Jaoin buttan.
- Demagraphiclnfarmation - SumweyResponses
Age DOUBLE Call Waiting DOUBLE =
Car DOUBLE CallerlD DOUBLE
Car Category DOUBLE [} COUNTER
Education DOUBLE Internet INTEGER
Empcat DOUBLE i tultline INTEGER
Ermplay DOUBLE g Mews DOUBLE
Gender VARCHAR Crvn CD Player DOUEBLE
D COUNTER O Fa DOUBLE |
Income DOLUBLE | Onwn PC DOLBLE
Incame Category DOUBLE Onwn PDA DOUBLE
Marital Status DOUBLE = Onwn T DOUBLE =
|‘| |.|_ T TR Nl Y Y | |L
4 ]
Join Type: | Inner =~ | [¥] Auta Jain Tables
| zgack || met= || Finish || cancel || Hew |

Establishing relationships. To create a relationship, drag a field from any table onto the field to
which you want to join it. The Database Wizard will draw a join line between the two fields,
indicating their relationship. These fields must be of the same data type.

Auto Join Tables. Attempts to automatically join tables based on primary/foreign keys or matching
field names and data type.

Join Type. If outer joins are supported by your driver, you can specify inner joins, left outer
joins, or right outer joins.

® Inner joins. An inner join includes only rows where the related fields are equal. In this
example, all rows with matching ID values in the two tables will be included.

m  Quter joins. In addition to one-to-one matching with inner joins, you can also use outer joins to
merge tables with a one-to-many matching scheme. For example, you could match a table
in which there are only a few records representing data values and associated descriptive
labels with values in a table containing hundreds or thousands of records representing survey
respondents. A left outer join includes all records from the table on the left and, from the table
on the right, includes only those records in which the related fields are equal. In a right outer
join, the join imports all records from the table on the right and, from the table on the left,
imports only those records in which the related fields are equal.
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The Limit Retrieved Cases step allows you to specify the criteria to select subsets of cases (rows).
Limiting cases generally consists of filling the criteria grid with criteria. Criteria consist of two

expressions and some relation between them. The expressions return a value of true, false, or

missing for each case.

If the result is true, the case is selected.

If the result is false or missing, the case is not selected.

Most criteria use one or more of the six relational operators (<, >, <=, >=, = and <>).

Expressions can include field names, constants, arithmetic operators, numeric and other

functions, and logical variables. You can use fields that you do not plan to import as variables.

Figure 3-6
Database Wizard, limiting retrieved cases

Q Database Wizard

Limit Retrieved Cases

Limit the cases that are retrieved by specifying selection criteria.
Tip: Fields and Functions can be added to an expression by dragging and dropping into a cell.
See help for how to express date and time values.

Criteria:

<|: [»

Functiohs

WS CI(strexpn
CHAR{asciicode)
COMNCAT(strexpr, strexprn
INSERT{strexpr,pos,len,n
LEFT{strexpr,count)
LTRIM{strexpr)
LEMGTH(strexpr)

LOCATEhaystack needle) &

[:]»

E

-

< R | [»

Connector Expression 1 Relation Expression 2

1

2

3

4

]

hi

4
ERandomly Sample Cases
Sampling Method Sample Size

) Retrieve cases and randomly select (%) Approximate percentage of all cases

- EREE Percentage: E
() Exact number of cases

Tip: Ifyou retrieve the cases and select
them in PSS, database aggregation is
unavailable.

< gack |[Cnea= || Finisn || cancel || Hew |

To build your criteria, you need at least two expressions and a relation to connect the expressions.

» To build an expression, choose one of the following methods:

® In an Expression cell, type field names, constants, arithmetic operators, numeric and other

functions, or logical variables.
®  Double-click the field in the Fields list.
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>

B Drag the field from the Fields list to an Expression cell.

B Choose a field from the drop-down menu in any active Expression cell.

To choose the relational operator (such as = or >), put your cursor in the Relation cell and either
type the operator or choose it from the drop-down menu.

If the SQL contains WHERE clauses with expressions for case selection, dates and times in
expressions need to be specified in a special manner (including the curly braces shown in the
examples):

m Date literals should be specified using the general form {d 'yyyy-mm-dd'}.
m  Time literals should be specified using the general form {t 'hh:mm:ss"'}.

m  Date/time literals (timestamps) should be specified using the general form {ts 'yyyy-mm-dd
hh:mm:ss'}.

m  The entire date and/or time value must be enclosed in single quotes. Years must be expressed
in four-digit form, and dates and times must contain two digits for each portion of the value.
For example January 1, 2005, 1:05 AM would be expressed as:

{ts '2005-01-01 01:05:00"'}

Functions. A selection of built-in arithmetic, logical, string, date, and time SQL functions is
provided. You can drag a function from the list into the expression, or you can enter any valid
SQL function. See your database documentation for valid SQL functions. A list of standard
functions is available at:

http://msdn2.microsoft.com/en-us/library/ms711813.aspx

Use Random Sampling. This option selects a random sample of cases from the data source. For
large data sources, you may want to limit the number of cases to a small, representative sample,
which can significantly reduce the time that it takes to run procedures. Native random sampling,
if available for the data source, is faster than SPSS random sampling, because SPSS random
sampling must still read the entire data source to extract a random sample.

m  Approximately. Generates a random sample of approximately the specified percentage of cases.
Since this routine makes an independent pseudorandom decision for each case, the percentage
of cases selected can only approximate the specified percentage. The more cases there are in
the data file, the closer the percentage of cases selected is to the specified percentage.

m  Exactly. Selects a random sample of the specified number of cases from the specified total
number of cases. If the total number of cases specified exceeds the total number of cases in
the data file, the sample will contain proportionally fewer cases than the requested number.

Note: If you use random sampling, aggregation (available in distributed mode with SPSS Server)
is not available.

Prompt For Value. You can embed a prompt in your query to create a parameter query. When
users run the query, they will be asked to enter information (based on what is specified here). You
might want to do this if you need to see different views of the same data. For example, you may
want to run the same query to see sales figures for different fiscal quarters.

» Place your cursor in any Expression cell, and click Prompt For Value to create a prompt.


http://msdn2.microsoft.com/en-us/library/ms711813.aspx
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Creating a Parameter Query

Use the Prompt for Value step to create a dialog box that solicits information from users each
time someone runs your query. This feature is useful if you want to query the same data source
by using different criteria.

Figure 3-7
Prompt for Value

ﬁ Prompt for ¥alue

Brompt String: Income category (1=Law, 2=Mediumn, 3=High) |

Information about data to be entered
Defaultyalue:h |

Allow user to selectvalue from list:

1
2
3

Data trpe: ’Number ']

[ continue U[ Cancel H Heln ]

To build a prompt, enter a prompt string and a default value. The prompt string is displayed each
time a user runs your query. The string should specify the kind of information to enter. If the user
is not selecting from a list, the string should give hints about how the input should be formatted.
An example is as follows: Enter a Quarter (Q1, Q2, Q83, ...).

Allow user to select value from list. If this check box is selected, you can limit the user to the values
that you place here. Ensure that your values are separated by returns.

Data type. Choose the data type here (Number, String, or Date).

The final result looks like this:

Figure 3-8
Userdefined prompt
Select Value for Query
Income categom [1=low, 2=medium, 3=high] QK

Aggregating Data

If you are in distributed mode, connected to a remote server (available with SPSS Server), you can
aggregate the data before reading it into SPSS .
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Figure 3-9
Database Wizard, aggregating data

Database Wizard - Distributed Mode

Aggregate Data

Y'ou cat aggregate wour data before retrieving it according to groups defined by break variables or press MNest to
retrieve the original cazez. The autput varisbles can be renamed on the nest panel.

Break Variable(s)
& demn: ID 2

% demo: AGE
2 demo: MARITAL »

& dema: ADDRESS

& demo: INCOME

B dema: INCCAT < >
& demn: CAR

& demo: CARCAT Agaregated Yariables

% deme: ED Summaries of Yariable(z)

% demo: EMPLOY Hame |
& dema: RETIRE

8. demo: EMPCAT »
& demo: GENDER
& dema: RESIDE
IO

P Wt

< > < b3

Function

[ Mumber of cases
Agagregation iz available only when connected o SPSS Server

< Back | Mest > | Firizh | Cancel Help

You can also aggregate data after reading it into SPSS , but preaggregating may save time for
large data sources.

» To create aggregated data, select one or more break variables that define how cases are grouped.

» Select one or more aggregated variables.
» Select an aggregate function for each aggregate variable.

» Optionally, create a variable that contains the number of cases in each break group.

Note: If you use SPSS random sampling, aggregation is not available.

Defining Variables

Variable names and labels. The complete database field (column) name is used as the variable
label. Unless you modify the variable name, the Database Wizard assigns variable names to each
column from the database in one of two ways:

m  [f the name of the database field forms a valid, unique variable name, the name is used as
the variable name.

m  [f the name of the database field does not form a valid, unique variable name, a new, unique
name is automatically generated.

Click any cell to edit the variable name.
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Converting strings to numeric values. Select the Recode to Numeric box for a string variable if you
want to automatically convert it to a numeric variable. String values are converted to consecutive
integer values based on alphabetical order of the original values. The original values are retained
as value labels for the new variables.

Width for variable-width string fields. This option controls the width of variable-width string
values. By default, the width is 255 bytes, and only the first 255 bytes (typically 255 characters in
single-byte languages) will be read. The width can be up to 32,767 bytes. Although you probably
don’t want to truncate string values, you also don’t want to specify an unnecessarily large value,
which will cause processing to be inefficient.

Minimize string widths based on observed values. Automatically set the width of each string
variable to the longest observed value.

Figure 3-10
Database Wizard, defining variables

5E| Database Wizard

Define Variables
Edit SPS5 wariable names and properties.
Mames wil be automatically generated if left blank.

To convett & string variable to numeric using the ariginal walues as value labels, check Recode to Mumeric.

Result Variable Name Data Type Recudt_a to
Humeric

demo: ID [} UM Eric =
demo: AGE AGE MUMEric

demo: MARITAL MARITAL MUMEric

demo: ADDRESS ADDRESS Mumeric

demo: INCOME INCOME Mumeric

demo: INCCAT INCCAT Mumeric

demo: CAR, CAR Mumeric

demo: CARCAT CARCAT Mumeric

demo: ED ED Mumeric

demo: EMPLOY EMPLOY Mumeric

demo: BETIRE RETIRE Mumeric —
demo: EMPCAT EMPCAT Mumeric

demo: GENDER GEMDER String

demo: RESIDE RESIDE Mumeric

demo: WIRELESS VARELESS Mumeric

demo: MULTLINE MLILTLIME PLFEric

demo: VOICE WOICE MUmEric |
|demo: PAGER PAGER Purmeric =4

Wicth for variable-width string figlds: 255 |:| Minimize string widths based on observed values

= Back ” Mext = JI Finish ” Cancel ” Helg

Sorting Cases

If you are in distributed mode, connected to a remote server (available with SPSS Server), you
can sort the data before reading it into SPSS .



28

Chapter 3

Figure 3-11

Database Wizard, sorting cases

Database Wizard - Distributed Mode

Sort Cases

By 4iEE

B MaRITAL
B 4DDRESS
ErINCOME
EnInCCaT
Emcan

B CaRcaT
EnED

B EMPLOY
ErRETIRE
B EMPLAT
EnGEMDER
ErRESIDE
B wIRELESS
J

(TRTIE AR

2]

b

You cat sort the data before it iz read inta SPSS or press Mest o get the data without sorting.

Sort befare retrieval by:

Wariable

Direction

Azcending

< Back | Mest > |

Sarting iz available only when connected to SPSS Server. Any variable: not given names oh the previous panel do not
appear in this variable list but will have names generated autarnatically.

Firizh | Cancel | Help

You can also sort data after reading it into SPSS , but presorting may save time for large data

sources.

Results

The Results step displays the SQL Select statement for your query.

B You can edit the SQL Select statement before you run the query, but if you click the Back
button to make changes in previous steps, the changes to the Select statement will be lost.

m  To save the query for future use, use the Save query to file section.

m To paste complete GET DATA syntax into a syntax window, select Paste it into the syntax editor

for further modification. Copying and pasting the Select statement from the Results window
will not paste the necessary command syntax.

Note: The pasted syntax contains a blank space before the closing quote on each line of SQL that
is generated by the wizard. These blanks are not superfluous. When the command is processed, all
lines of the SQL statement are merged together in a very literal fashion. Without the space, there

would be no space between the last character on one line and first character on the next line.
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Figure 3-12
Database Wizard, results panel

"Database Wizard

Results

Vour selection has resulted in the following SAL query:

SELECT ID. &GE. MARITAL, ADDRESS. IMCOME, IMCCAT, CaR, CARCAT. ED. EMPLOY. RETIRE.
EMPCAT, GEMDER, RESIDE, WIRELESS, MULTLINE, WOICE, PAGER, INTERMET, CALLID,
CallywalT, OWNTY, DWwWHWCR, DWwWHCD, OWNPDA, OWNPC, OWNF&X, NEWS, RESPONSE FROM
demo

“What would you like to do with this queny?

(%) Betrieve the data | have selected.

() Paste it inko the: syntax editor for further modification

Save quen ta file

Browse

[ Finish |[ Cancel ] [ Help ]

Text Wizard

The Text Wizard can read text data files formatted in a variety of ways:
m  Tab-delimited files

B Space-delimited files

m  Comma-delimited files

m  Fixed-field format files

For delimited files, you can also specify other characters as delimiters between values, and you
can specify multiple delimiters.

To Read Text Data Files

» From the menus choose:
File
Read Text Data...
» Select the text file in the Open Data dialog box.

» Follow the steps in the Text Wizard to define how to read the data file.
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Text Wizard: Step 1

Figure 3-13
Text Wizard: Step 1

Text Import Wizard - Step 1 of 6

ﬂ- “Welcorme to the text impart wizard!

This wizard will help you read data from pour text file and
specify information about the variables.

T P B [oes pour text file match a predefined format?
Oes
& No

"

Text file: Z:5pubshdatadelimit bt

u] 10 20 30 40 50
L 1 1 1 1 1 1 1 1 1 1

ID, Job_category, Region, Division, Travel,Current sales, (A
1,2,3,2,2,570000,270000,3

E,1,3,2,2,402000,25300,3
B,1, ,1,2,257400,144000,1 [

3] (2]

v/

[ Cancel ] [ Help ]

The text file is displayed in a preview window. You can apply a predefined format (previously

saved from the Text Wizard) or follow the steps in the Text Wizard to specify how the data
should be read.
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Text Wizard: Step 2

Figure 3-14
Text Wizard: Step 2

Text Import Wizard - Step 2 of 6
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[ <Back || Mewt> [ Cancel ][ Help ]

This step provides information about variables. A variable is similar to a field in a database. For
example, each item in a questionnaire is a variable.

How are your variables arranged? To read your data properly, the Text Wizard needs to know how
to determine where the data value for one variable ends and the data value for the next variable
begins. The arrangement of variables defines the method used to differentiate one variable

from the next.

m Delimited. Spaces, commas, tabs, or other characters are used to separate variables. The
variables are recorded in the same order for each case but not necessarily in the same column
locations.

m  Fixed width. Each variable is recorded in the same column location on the same record (line)
for each case in the data file. No delimiter is required between variables. In fact, in many text
data files generated by computer programs, data values may appear to run together without
even spaces separating them. The column location determines which variable is being read.

Are variable names included at the top of your file? If the first row of the data file contains
descriptive labels for each variable, you can use these labels as variable names. Values that don’t
conform to variable naming rules are converted to valid variable names.
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Text Wizard: Step 3 (Delimited Files)

Figure 3-15
Text Wizard: Step 3 (for delimited files)

Text Import Wizard - Delimited Step 3 of 6

The first caze of data beging on which line number? 2

[¢l

Howw are your cazes reprezented?
() Each line represents a case

() & specific number of variables represents a case: 1

[¢l

Howe marny cazes do vou want bo impork?
() &l of the cases
() The first 1000 cases.

&

() & random percentage of the cases [approximate): |10 2

Data preview

u} 10 20 30 40 50

.Z,570000, 270000, 3 )
,2,402000,25300, 3 El
,2,257400, 144000, 1 _
,2,262800, 158400, 1 M
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This step provides information about cases. A case is similar to a record in a database. For
example, each respondent to a questionnaire is a case.

The first case of data begins on which line number? Indicates the first line of the data file that
contains data values. If the top line(s) of the data file contain descriptive labels or other text that
does not represent data values, this will not be line 1.

How are your cases represented? Controls how the Text Wizard determines where each case
ends and the next one begins.

m  Each line represents a case. Each line contains only one case. It is fairly common for each case
to be contained on a single line (row), even though this can be a very long line for data files
with a large number of variables. If not all lines contain the same number of data values, the
number of variables for each case is determined by the line with the greatest number of data
values. Cases with fewer data values are assigned missing values for the additional variables.

m A specific number of variables represents a case. The specified number of variables for each
case tells the Text Wizard where to stop reading one case and start reading the next. Multiple
cases can be contained on the same line, and cases can start in the middle of one line and
be continued on the next line. The Text Wizard determines the end of each case based on
the number of values read, regardless of the number of lines. Each case must contain data
values (or missing values indicated by delimiters) for all variables, or the data file will be
read incorrectly.
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How many cases do you want to import? You can import all cases in the data file, the first n cases
(n is a number you specify), or a random sample of a specified percentage. Since the random
sampling routine makes an independent pseudo-random decision for each case, the percentage of
cases selected can only approximate the specified percentage. The more cases there are in the data
file, the closer the percentage of cases selected is to the specified percentage.

Text Wizard: Step 3 (Fixed-Width Files)

Figure 3-16
Text Wizard: Step 3 (for fixed-width files)

Text Import Wizard - Fixed Width Step 3 of &

[¢}

The first caze of data begins on which line number? 1

[¢}

How many lines reprezent a caze? 1
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() & percentage of the cases: 10 ::: %
Data preview
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41 3.0012 (262,800 §158,400 1 laal
[ <Back | Mewt> Cancel ] [ Help

This step provides information about cases. A case is similar to a record in a database. For
example, each respondent to questionnaire is a case.

The first case of data begins on which line number? Indicates the first line of the data file that
contains data values. If the top line(s) of the data file contain descriptive labels or other text that
does not represent data values, this will not be line 1.

How many lines represent a case? Controls how the Text Wizard determines where each case ends
and the next one begins. Each variable is defined by its line number within the case and its column
location. You need to specify the number of lines for each case to read the data correctly.

How many cases do you want to import? You can import all cases in the data file, the first n cases
(n is a number you specify), or a random sample of a specified percentage. Since the random
sampling routine makes an independent pseudo-random decision for each case, the percentage of
cases selected can only approximate the specified percentage. The more cases there are in the data
file, the closer the percentage of cases selected is to the specified percentage.
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Text Wizard: Step 4 (Delimited Files)

Figure 3-17
Text Wizard: Step 4 (for delimited files)

Text Import Wizard - Delimited Step 4 of 6
“w'hich delimiters appear bebween variables? “What iz the test qualifier?
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Data preview
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. F ES a A Acnann aEoan
[ <Back | Mewt> [ Cancel ] [ Help ]

This step displays the Text Wizard’s best guess on how to read the data file and allows you to
modify how the Text Wizard will read variables from the data file.

Which delimiters appear between variables? Indicates the characters or symbols that separate data
values. You can select any combination of spaces, commas, semicolons, tabs, or other characters.
Multiple, consecutive delimiters without intervening data values are treated as missing values.

What is the text qualifier? Characters used to enclose values that contain delimiter characters.
For example, if a comma is the delimiter, values that contain commas will be read incorrectly
unless there is a text qualifier enclosing the value, preventing the commas in the value from being
interpreted as delimiters between values. CSV-format data files exported from Excel use a double

quotation mark (“) as a text qualifier. The text qualifier appears at both the beginning and the
end of the value, enclosing the entire value.
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Text Wizard: Step 4 (Fixed-Width Files)

Figure 3-18
Text Wizard: Step 4 (for fixed-width files)

B Text Import Wizard - Fixed Width Step 4 of 6
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This step displays the Text Wizard’s best guess on how to read the data file and allows you to
modify how the Text Wizard will read variables from the data file. Vertical lines in the preview
window indicate where the Text Wizard currently thinks each variable begins in the file.

Insert, move, and delete variable break lines as necessary to separate variables. If multiple lines
are used for each case, the data will be displayed as one line for each case, with subsequent
lines appended to the end of the line.

Notes:

For computer-generated data files that produce a continuous stream of data values with no
intervening spaces or other distinguishing characteristics, it may be difficult to determine where
each variable begins. Such data files usually rely on a data definition file or some other written
description that specifies the line and column location for each variable.
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Text Wizard: Step 5

Figure 3-19
Text Wizard: Step 5
Text Import Wizard - Step 5 of 6
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This steps controls the variable name and the data format that the Text Wizard will use to read
each variable and which variables will be included in the final data file.

Variable name. You can overwrite the default variable names with your own variable names. If
you read variable names from the data file, the Text Wizard will automatically modify variable
names that don’t conform to variable naming rules. Select a variable in the preview window and
then enter a variable name.

Data format. Select a variable in the preview window and then select a format from the
drop-down list. Shift-click to select multiple contiguous variables or Ctrl-click to select multiple
noncontiguous variables.

Text Wizard Formatting Options

Formatting options for reading variables with the Text Wizard include:
Do not import. Omit the selected variable(s) from the imported data file.
Numeric. Valid values include numbers, a leading plus or minus sign, and a decimal indicator.

String. Valid values include virtually any keyboard characters and embedded blanks. For delimited
files, you can specify the number of characters in the value, up to a maximum of 32,767. By
default, the Text Wizard sets the number of characters to the longest string value encountered for
the selected variable(s). For fixed-width files, the number of characters in string values is defined
by the placement of variable break lines in step 4.
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Date/Time. Valid values include dates of the general format dd-mm-yyyy, mm/dd/yyyy, dd.mm.yyyy,
yyyy/mm/dd, hh:mm:ss, and a variety of other date and time formats. Months can be represented
in digits, Roman numerals, or three-letter abbreviations, or they can be fully spelled out. Select a
date format from the list.

Dollar. Valid values are numbers with an optional leading dollar sign and optional commas as
thousands separators.

Comma. Valid values include numbers that use a period as a decimal indicator and commas as
thousands separators.

Dot. Valid values include numbers that use a comma as a decimal indicator and periods as
thousands separators.

Note: Values that contain invalid characters for the selected format will be treated as missing.
Values that contain any of the specified delimiters will be treated as multiple values.

Text Wizard: Step 6

Figure 3-20
Text Wizard: Step 6

Text Import Wizard - Step 6 of 6
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This is the final step of the Text Wizard. You can save your specifications in a file for use when
importing similar text data files. You can also paste the syntax generated by the Text Wizard
into a syntax window. You can then customize and/or save the syntax for use in other sessions
or in production jobs.

Cache data locally. A data cache is a complete copy of the data file, stored in temporary disk space.
Caching the data file can improve performance.
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Reading Dimensions Data

>

On Microsoft Windows operating systems, you can read data from SPSS Dimensions products,
including Quanvert, Quancept, and mrinterview. (Note: This feature is only available with SPSS
installed on Microsoft Windows operating systems.)

To read Dimensions data sources, you must have the following items installed:
m  NET framework
®  Dimensions Data Model and OLE DB Access

Versions of these components that are compatible with this release can be installed from the
installation CD and are available on the AutoPlay menu. You can read Dimensions data sources
only in local analysis mode. This feature is not available in distributed analysis mode using
SPSS Server.

To read data from a Dimensions data source:
In any open SPSS window, from the menus choose:
File

Open Dimensions Data

On the Connection tab of Data Link Properties, specify the metadata file, the case data type,
and the case data file.

Click OK.

In the Dimensions Data Import dialog box, select the variables that you want to include and select
any case selection criteria.

Click OK to read the data.

Data Link Properties Connection Tab

To read a Dimensions data source, you need to specify:

Metadata Location. The metadata document file (.mdd) that contains questionnaire definition
information.

Case Data Type. The format of the case data file. Available formats include:

®  Quancept Data File (DRS). Case data in a Quancept .drs, .drz, or .dru file.

®  Quanvert Database. Case data in a Quanvert database.

®  Dimensions Database (MS SQL Server). Case data in an SPSS MR relational database in SQL
Server. This option can be used to read data that are collected by using mrinterview.

® Dimensions XML Data File. Case data in an XML file.

Case Data Location. The file that contains the case data. The format of this file must be consistent
with the selected case data type.
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Figure 3-21
Data Link Properties: Connection tab

Data Link Properties

Provider | Connection | sdvanced | Al
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I I‘

Test Connection

[ Ok, |[ Cancel H Help ]

Note: The extent to which other settings on the Connection tab or any settings on the other Data
Link Properties tabs may or may not affect reading Dimensions data into SPSS is not known, so
we recommend that you do not change any of them.

Select Variables Tab

You can select a subset of variables to read. By default, all standard variables in the data source
are displayed and selected.

m  Show System variables. Displays any “system” variables, including variables that indicate
interview status (in progress, completed, finish date, and so on). You can then select any
system variables that you want to include. By default, all system variables are excluded.

m  Show Codes variables. Displays any variables that represent codes that are used for open-ended
“Other” responses for categorical variables. You can then select any Codes variables that you
want to include. By default, all Codes variables are excluded.

m  Show SourceFile variables. Displays any variables that contain filenames of images of scanned
responses. You can then select any SourceFile variables that you want to include. By default,
all SourceFile variables are excluded.
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Figure 3-22
Dimensions Data Import: Select Variables tab
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Case Selection Tab

For Dimensions data sources that contain system variables, you can select cases based on a
number of system variable criteria. You do not need to include the corresponding system variables
in the list of variables to read, but the necessary system variables must exist in the source data to
apply the selection criteria. If the necessary system variables do not exist in the source data, the
corresponding selection criteria are ignored.

Data collection status. You can select respondent data, test data, or both. You can also select cases
based on any combination of the following interview status parameters:

Completed successfully
Active/in progress
Timed out

Stopped by script
Stopped by respondent

Interview system shutdown

Signal (terminated by a signal statement in the script)

Data collection finish date. You can select cases based on the data collection finish date.

m  Start Date. Cases for which data collection finished on or after the specified date are included.
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m  End Date. Cases for
does not include ca:

m [f you specify both

Data Files

which data collection finished before the specified date are included. This
ses for which data collection finished on the end date.

a start date and end date, this defines a range of finish dates from the

start date to (but not including) the end date.

Figure 3-23

Dimensions Data Import: Case Selection tab
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File Information

A data file contains much more than raw data. It also contains any variable definition information,

including:
B Variable names

® Variable formats

m  Descriptive variable and value labels

This information is stored in the dictionary portion of the data file. The Data Editor provides
one way to view the variable definition information. You can also display complete dictionary
information for the active dataset or any other data file.

To Display Data File Information

» From the menus in the Data Editor window choose:

File

Display Data File Information

» For the currently open data file, choose Working File.

» For other data files, choose External File, and then select the data file.
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The data file information is displayed in the Viewer.

Saving Data Files

In addition to saving data files in SPSS format, you can save data in a wide variety of external
formats, including:

m  Excel and other spreadsheet formats
Tab-delimited and CSV text files
SAS

Stata

Database tables

To Save Modified Data Files

Make the Data Editor the active window (click anywhere in the window to make it active).

From the menus choose:
File
Save

The modified data file is saved, overwriting the previous version of the file.

Note: A data file saved in Unicode mode cannot be read by versions of SPSS prior to 16.0. To
save a Unicode data file in a format that can be read by earlier releases, open the file in code page
mode and re-save it. The file will be saved in the encoding based on the current locale. Some data
loss may occur if the file contains characters not recognized by the current locale. For information
on switching between Unicode mode and code page mode, see General Options on p. 454.

Saving Data Files in External Formats

>

>

Make the Data Editor the active window (click anywhere in the window to make it active).
From the menus choose:
File

Save As...

Select a file type from the drop-down list.

Enter a filename for the new data file.

To write variable names to the first row of a spreadsheet or tah-delimited data file:

Click Write variable names to spreadsheet in the Save Data As dialog box.

To save value labels instead of data values in Excel files:

Click Save value labels where defined instead of data values in the Save Data As dialog box.
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To save value labels to a SAS syntax file (active only when a SAS file type is selected):

» Click Save value labels into a .sas file in the Save Data As dialog box.
For information on exporting data to database tables, see Exporting to a Database on p. 48.

For information on exporting data for use in Dimensions applications, see Exporting to
Dimensions on p. 60.

Saving Data: Data File Types
You can save data in the following formats:

SPSS (*.sav). SPSS format.

m  Data files saved in SPSS format cannot be read by versions of the software prior to version
7.5. Data files saved in Unicode mode cannot be read by releases of SPSS prior to SPSS 16.0
For more information, see General Options in Chapter 45 on p. 454.

B When using data files with variable names longer than eight bytes in version 10.x or 11.x,
unique, eight-byte versions of variable names are used—but the original variable names are
preserved for use in release 12.0 or later. In releases prior to 10.0, the original long variable
names are lost if you save the data file.

®  When using data files with string variables longer than 255 bytes in versions prior to release
13.0, those string variables are broken up into multiple 255-byte string variables.

Version 7.0 (*.sav). Version 7.0 format. Data files saved in version 7.0 format can be read by
version 7.0 and earlier versions but do not include defined multiple response sets or Data Entry
for Windows information.

SPSS/PC+ (*.sys). SPSS/PC+ format. If the data file contains more than 500 variables, only the
first 500 will be saved. For variables with more than one defined user-missing value, additional
user-missing values will be recoded into the first defined user-missing value.

SPSS Portable (*.por). Portable format that can be read by other versions of SPSS and versions on
other operating systems. Variable names are limited to eight bytes and are automatically converted
to unique eight-byte names if necessary. In most cases, saving data in portable format is no
longer necessary, since SPSS-format data files should be platform/operating system independent.
You cannot save data files in portable file in Unicode mode. For more information, see General
Options in Chapter 45 on p. 454.

Tab-delimited (*.dat). Text files with values separated by tabs. (Note: Tab characters embedded
in string values are preserved as tab characters in the tab-delimited file. No distinction is made
between tab characters embedded in values and tab characters that separate values.)

Comma-delimited (*.csv). Text files with values separated by commas or semicolons. If the current
SPSS decimal indicator is a period, values are separated by commas. If the current decimal
indicator is a comma, values are separated by semicolons.

Fixed ASCII (*.dat). Text file in fixed format, using the default write formats for all variables. There
are no tabs or spaces between variable fields.
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Excel 2007 (*.xIsx). Microsoft Excel 2007 XLSX-format workbook. The maximum number of
variables is 16,000; any additional variables beyond the first 16,000 are dropped. If the dataset
contains more than one million cases, multiple sheets are created in the workbook.

Excel 97 through 2003 (*.xls). Microsoft Excel 97 workbook. The maximum number of variables
is 256; any additional variables beyond the first 256 are dropped. If the dataset contains more
than 65,356 cases, multiple sheets are created in the workbook.

Excel 2.1 (*.xIs). Microsoft Excel 2.1 spreadsheet file. The maximum number of variables is 256,
and the maximum number of rows is 16,384.

1-2-3 Release 3.0 (*.wk3). Lotus 1-2-3 spreadsheet file, release 3.0. The maximum number of
variables that you can save is 256.

1-2-3 Release 2.0 (*.wk1). Lotus 1-2-3 spreadsheet file, release 2.0. The maximum number of
variables that you can save is 256.

1-2-3 Release 1.0 (*.wks). Lotus 1-2-3 spreadsheet file, release 1A. The maximum number of
variables that you can save is 256.

SYLK (*.slk). Symbolic link format for Microsoft Excel and Multiplan spreadsheet files. The
maximum number of variables that you can save is 256.

dBASE IV (*.dbf). dBASE 1V format.

dBASE Il (*.dbf). dBASE III format.

dBASE Il (*.dbf). dBASE II format.

SAS v7+ Windows short extension (*.sd7). SAS versions 7-8 for Windows short filename format.

SAS v7+ Windows long extension (*.sas7bdat). SAS versions 7-8 for Windows long filename
format.

SAS v7+ for UNIX (*.ssd01). SAS v8 for UNIX.

SAS v6 for Windows (*.sd2). SAS v6 file format for Windows/OS2.

SAS v6 for UNIX (*.ssd01). SAS v6 file format for UNIX (Sun, HP, IBM).
SAS v6 for Alpha/OSF (*.ssd04). SAS v6 file format for Alpha/OSF (DEC UNIX).
SAS Transport (*.xpt). SAS transport file.

Stata Version 8 Intercooled (*.dta).

Stata Version 8 SE (*.dta).

Stata Version 7 Intercooled (*.dta).

Stata Version 7 SE (*.dta).

Stata Version 6 (*.dta).

Stata Versions 4-5 (*.dta).

Saving File Options

For spreadsheet, tab-delimited files, and comma-delimited files, you can write variable names
to the first row of the file.
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Saving Data Files in Excel Format

You can save your data in one of three Microsoft Excel file formats. Excel 2.1, Excel 97, and
Excel 2007.

Excel 2.1 and Excel 97 are limited to 256 columns; so only the first 256 variables are included.
Excel 2007 is limited to 16,000 columns; so only the first 16,000 variables are included.
Excel 2.1 is limited to 16,384 rows; so only the first 16,384 cases are included.

Excel 97 and Excel 2007 also have limits on the number of rows per sheet, but workbooks can
have multiple sheets, and multiple sheets are created if the single-sheet maximum is exceeded.

Variable Types

The following table shows the variable type matching between the original data in SPSS and
the exported data in Excel.

SPSS Variable Type Excel Data Format
Numeric 0.00; #,##0.00; ...
Comma 0.00; #,##0.00; ...
Dollar $#.##0); ...

Date d-mmm-yyyy

Time hh:mm:ss

String General

Saving Data Files in SAS Format

Special handling is given to various aspects of your data when saved as a SAS file. These cases
include:

Certain characters that are allowed in SPSS variable names are not valid in SAS, such as @, #,
and $. These illegal characters are replaced with an underscore when the data are exported.

SPSS variable names that contain multibyte characters (for example, Japanese or Chinese
characters) are converted to variables names of the general form Vunn, where nnn is an
integer value.

SPSS variable labels containing more than 40 characters are truncated when exported to
a SAS vo6 file.

Where they exist, SPSS variable labels are mapped to the SAS variable labels. If no variable
label exists in the SPSS data, the variable name is mapped to the SAS variable label.

SAS allows only one value for system-missing, whereas SPSS allows numerous
system-missing values. As a result, all system-missing values in SPSS are mapped to a
single system-missing value in the SAS file.
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Save Value Labels

You have the option of saving the values and value labels associated with your data file to a
SAS syntax file. For example, when the value labels for the cars.sav data file are exported,
the generated syntax file contains:

libname library '\spss\' ;

proc format library = library ;

value ORIGIN /* Country of Origin */

1 = 'American'
2 = 'European'
3 = 'Japanese’' ;

value CYLINDER /* Number of Cylinders */

3 = '3 Cylinders'
4 = '4 Cylinders'
5 = '5 Cylinders'
6 = '6 Cylinders'
8 = '8 Cylinders' ;

value FILTER__ /* cylrec = 1 | cylrec = 2 (FILTER) */
0 = 'Not Selected'

1 = 'Selected' ;

proc datasets library = library ;
modify cars;
format ORIGIN ORIGIN. ;
format CYLINDER CYLINDER. ;

format FILTER__ FILTER

.7

quit;

This feature is not supported for the SAS transport file.

Variable Types

The following table shows the variable type matching between the original data in SPSS and
the exported data in SAS.

SPSS Variable Type SAS Variable Type SAS Data Format
Numeric Numeric 12
Comma Numeric 12
Dot Numeric 12

Scientific Notation Numeric 12
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SPSS Variable Type
Date

Date (Time)
Dollar
Custom Currency

String

SAS Variable Type

Numeric

Numeric
Numeric
Numeric

Character

Data Files

SAS Data Format

(Date) for example,
MMDDYY10, ...

Timel8
12
12
$8

Saving Data Files in Stata Format

® Data can be written in Stata 5—8 format and in both Intercooled and SE format (versions
7 and 8 only).

m Data files that are saved in Stata 5 format can be read by Stata 4.

m  The first 80 bytes of variable labels are saved as Stata variable labels.

®  For numeric variables, the first 80 bytes of value labels are saved as Stata value labels. For
string variables, value labels are dropped.

m  For versions 7 and 8, the first 32 bytes of variable names in case-sensitive form are saved as
Stata variable names. For earlier versions, the first eight bytes of variable names are saved
as Stata variable names. Any characters other than letters, numbers, and underscores are
converted to underscores.

m  SPSS variable names that contain multibyte characters (for example, Japanese or Chinese
characters) are converted to variable names of the general form Vnnn, where nnn is an
integer value.

m  For versions 5-6 and Intercooled versions 7-8, the first 80 bytes of string values are saved.
For Stata SE 7-8, the first 244 bytes of string values are saved.

m  For versions 5-6 and Intercooled versions 7-8, only the first 2,047 variables are saved. For
Stata SE 7-8, only the first 32,767 variables are saved.

SPSS Variable Type Stata Variable Type Stata Data Format

Numeric Numeric g

Comma Numeric g

Dot Numeric g

Scientific Notation Numeric g

Date*, Datetime Numeric DmY

Time, DTime Numeric g (number of seconds)

Wkday Numeric g (1-7)

Month Numeric g (1-12)

Dollar Numeric g

Custom Currency Numeric g

String String s

*Date, Adate, Edate, SDate, Jdate, Qyr, Moyr, Wkyr
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Saving Subsets of Variables

Figure 3-24
Save Data As Variables dialog box
= Save Data As: Variables x

Cnlyvariables marked with an X will be saved to the specified data file.

Keep | Mame Lahel Qrder

age Age inyears 1 =
marital Marital status 2
address Years at curme... 3 3
income Househald inc... 4 —
inccat Incame categ... ] Drop All
car FPrice of primar... B

carcat Frimary vehicl... 7

ed Level of educa... 8

employ Years with cur.. g ||
redire Retired 10 -

Selected: 30 of 30 variables.

[_continue ||| cancet ||  Hew |

The Save Data As Variables dialog box allows you to select the variables that you want saved in
the new data file. By default, all variables will be saved. Deselect the variables that you don’t
want to save, or click Drop All and then select the variables that you want to save.

Visible Only. Selects only variables in variable sets currently in use. For more information, see
Use Variable Sets in Chapter 44 on p. 450.

To Save a Subset of Variables
Make the Data Editor the active window (click anywhere in the window to make it active).
From the menus choose:
File
Save As...

Click Variables.

Select the variables that you want to save.

Exporting to a Database

You can use the Export to Database Wizard to:
m  Replace values in existing database table fields (columns) or add new fields to a table.
B Append new records (rows) to a database table.

m  Completely replace a database table or create a new table.
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To export data to a database:

From the menus in the Data Editor window for the dataset that contains the data you want to
export, choose:
File

Export to Database

Select the database source.

Follow the instructions in the export wizard to export the data.

Creating Database Fields from SPSS Variables

When creating new fields (adding fields to an existing database table, creating a new table,
replacing a table), you can specify field names, data type, and width (where applicable).

Field name. The default field names are the same as the SPSS variable names. You can change the
field names to any names allowed by the database format. For example, many databases allow
characters in field names that aren’t allowed in variable names, including spaces. Therefore, a
variable name like CallWaiting could be changed to the field name Call Waiting.

Type. The export wizard makes initial data type assignments based on the standard ODBC data
types or data types allowed by the selected database format that most closely matches the defined
SPSS data format—but databases can make type distinctions that have no direct equivalent in
SPSS, and vice versa. For example, most numeric values in SPSS are stored as double-precision
floating-point values, whereas database numeric data types include float (double), integer, real,
and so on. In addition, many databases don’t have equivalents to SPSS time formats. You can
change the data type to any type available in the drop-down list.

As a general rule, the basic data type (string or numeric) for the variable should match the basic
data type of the database field. If there is a data type mismatch that cannot be resolved by the
database, an error results and no data are exported to the database. For example, if you export a
string variable to a database field with a numeric data type, an error will result if any values of the
string variable contain non-numeric characters.

Width. You can change the defined width for string (char, varchar) field types. Numeric field
widths are defined by the data type.

By default, SPSS variable formats are mapped to database field types based on the following
general scheme. Actual database field types may vary, depending on the database.

SPSS Variable Format Database Field Type

Numeric Float or Double

Comma Float or Double

Dot Float or Double

Scientific Notation Float or Double

Date Date or Datetime or Timestamp
Datetime Datetime or Timestamp

Time, DTime Float or Double (number of seconds)
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SPSS Variable Format Database Field Type
Wkday Integer (1-7)
Month Integer (1-12)
Dollar Float or Double
Custom Currency Float or Double
String Char or Varchar

User-Missing Values

There are two options for the treatment of user-missing values when data from variables are
exported to database fields:

m  Export as valid values. User-missing values are treated as regular, valid, nonmissing values.

m  Export numeric user-missing as nulls and export string user-missing values as blank spaces.

Numeric user-missing values are treated the same as system-missing values. String
user-missing values are converted to blank spaces (strings cannot be system-missing).

Selecting a Data Source

In the first panel of the Export to Database Wizard, you select the data source to which you
want to export data.

Figure 3-25
Export to Database Wizard, selecting a data source

Export to Database Wizard

Welcome to the Export to Database Wizard!

The Expart ko Database Wizard helps yvou export data from the active SPSS dataset ko a database. To start, select a data source.

ODBC Data Sources

&3 dBasE Files

%ﬂ Excel Files

lQEMS Access Database

Add ODEC Data Source. ..

You can export data to any database source for which you have the appropriate ODBC driver.
(Note: Exporting data to OLE DB data sources is not supported.)
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If you do not have any ODBC data sources configured, or if you want to add a new data source,
click Add ODBC Data Source.

B On Linux operating systems, this button is not available. ODBC data sources are specified in
odbc.ini, and the ODBCINI environment variables must be set to the location of that file. For
more information, see the documentation for your database drivers.

®m In distributed analysis mode (available with SPSS Server), this button is not available. To add
data sources in distributed analysis mode, see your system administrator.

An ODBC data source consists of two essential pieces of information: the driver that will be used
to access the data and the location of the database you want to access. To specify data sources,
you must have the appropriate drivers installed. For local analysis mode, you can install drivers
for a variety of database formats from the SPSS installation CD.

Some data sources may require a login ID and password before you can proceed to the next step.

Choosing How to Export the Data

After you select the data source, you indicate the manner in which you want to export the data.

Figure 3-26
Export to Database Wizard, choosing how to export

Export to Database Wizard

Choose how to export the data

Connected to Database: z:ipubsispssidatajobsidm_demao.mdb

Expart Methads

* (%) Replace values in existing Fields

ﬂ To use this option, vou may need ko know which variables are the primary kews,

+ () add new fields b an existing table
-@ To use this option, you may need to know which variables are the primary keys.

() Append new records ko an existing kable

-’E () Drop an existing table and create a new tabls of the same name
—"% () Create a new table

< Back ” Met = ” Finish ][ Cancel ][ Help

The following choices are available for exporting data to a database:

m Replace values in existing fields. Replaces values of selected fields in an existing table with
values from the selected variables in the active dataset. For more information, see Replacing
Values in Existing Fields on p. 55.
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Add new fields to an existing table. Creates new fields in an existing table that contain the
values of selected variables in the active dataset. For more information, see Adding New
Fields on p. 56. This option is not available for Excel files.

Append new records to an existing table. Adds new records (rows) to an existing table
containing the values from cases in the active dataset. For more information, see Appending
New Records (Cases) on p. 57.

Drop an existing table and create a new table of the same name. Deletes the specified table
and creates a new table of the same name that contains selected variables from the active
dataset. All information from the original table, including definitions of field properties
(for example, primary keys, data types) is lost. For more information, see Creating a New
Table or Replacing a Table on p. 58.

Create a new table. Creates a new table in the database containing data from selected variables
in the active dataset. The name can be any value that is allowed as a table name by the data
source. The name cannot duplicate the name of an existing table or view in the database. For
more information, see Creating a New Table or Replacing a Table on p. 58.

Selecting a Table

When modifying or replacing a table in the database, you need to select the table to modify or
replace. This panel in the Export to Database Wizard displays a list of tables and views in the
selected database.

Figure 3-27
Export to Database Wizard, selecting a table or view

Export to Database Wizard

Select a table or view ﬂ

Connected to Database: dm_demo.mdb

Tables and Wiews:

Combined3ubset
CombinedTable
DemographicInformation
SurveyResponses

Walue Labels

Show: Tables [ views Synonyms [ 5ystem tables

< Back ” Mext = ” Finish ][ Cancel ][ Help
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By default, the list displays only standard database tables. You can control the type of items
that are displayed in the list:

m Tables. Standard database tables.

m  Views. Views are virtual or dynamic “tables” defined by queries. These can include joins of
multiple tables and/or fields derived from calculations based on the values of other fields. You
can append records or replace values of existing fields in views, but the fields that you can
modify may be restricted, depending on how the view is structured. For example, you cannot
modify a derived field, add fields to a view, or replace a view.

B Synonyms. A synonym is an alias for a table or view, typically defined in a query.

System tables. System tables define database properties. In some cases, standard database
tables may be classified as system tables and will be displayed only if you select this option.
Access to real system tables is often restricted to database administrators.

Selecting Cases to Export

Case selection in the Export to Database Wizard is limited either to all cases or to cases selected
using a previously defined filter condition. If no case filtering is in effect, this panel will not
appear, and all cases in the active dataset will be exported.

Figure 3-28
Export to Database Wizard, selecting cases to export
Export to Database Wizard
Select cases to export EH
-
H+H
Export all cases or use an existing filer condition to export: a subset of cases,
‘which cases do wou want to export?
() all cases
=] -
=¥ -
-+ -+
-+ -+
= -
= -
=¥ -
=¥ -

(C)Filtered cases

+
+

For information on defining a filter condition for case selection, see Select Cases on p. 180.
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Matching Cases to Records

When adding fields (columns) to an existing table or replacing the values of existing fields,
you need to make sure that each case (row) in the active dataset is correctly matched to the
corresponding record in the database.

m In the database, the field or set of fields that uniquely identifies each record is often designated
as the primary key.

B You need to identify which variable(s) correspond to the primary key field(s) or other fields
that uniquely identify each record.

m  The fields don’t have to be the primary key in the database, but the field value or combination
of field values must be unique for each case.

To match variables with fields in the database that uniquely identify each record:

» Drag and drop the variable(s) onto the corresponding database fields.
or

» Select a variable from the list of variables, select the corresponding field in the database table, and
click Connect.

To delete a connection line:

» Select the connection line and press the Delete key.

Figure 3-29
Export to Database Wizard, matching cases to records

Export to Database Wizard

Match cases to records v

SSSES

‘Which wariables and fields should be used ta match cases in the dataset with records in the table or view? Only the recards that
makch will be changed.

Toindicate that a variable in the dataset corresponds to a field in the table or view, select the variable and the field and then
click the Connect button. 4 line will be drawn ko connect the wariable ko the field, Alkernatively, you may drag the wariable ko the
field and drop it

To remave aline, select it and press the Delete key,

5PSS: [SurveySubset] Table: SurveySubset
&ID [1D] | ——in counter
é)WireIess [wireless] Nre.lass fiouble
fMu\tIine [Multline] Mu?lllne !rrteger
“oice [Yoice] Veice !meger
& Pager [Pager] :::2:: p :ﬁzﬁz
& Intermet: [Internet] CalleriD integer
fCallerID [CallerID] SurveyDate datetime
g@surveyDate [surveyDate] Comments varchar
@& Comments [Comments] |
-
Right-click an a variable for mare
informnation
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Note: The variable names and database field names may not be identical (since database field
names may contain characters not allowed in SPSS variable names), but if the active dataset was
created from the database table you are modifying, either the variable names or the variable labels
will usually be at least similar to the database field names.

Replacing Values in Existing Fields

To replace values of existing fields in a database:

» In the Choose how to export the data panel of the Export to Database Wizard, select Replace
values in existing fields.

» In the Select a table or view panel, select the database table.

» In the Match cases to records panel, match the variables that uniquely identify each case to the
corresponding database field names.

» For each field for which you want to replace values, drag and drop the variable that contains the
new values into the Source of values column, next to the corresponding database field name.

Figure 3-30
Export to Database Wizard, replacing values of existing fields

Export to Database Wizard

Select variables to store in existing fields ﬂ%

Ta replace the walues in a table figld with the walues of a dataset variable, place the variable in the cell next to the field name.
Use the arrow buttons or drag and drop.

Match cases to records! ID=SurveysSubset. 1D

SPSS: [SurveySubset] Table: SurveySubset
yWireless [Wireless] | Source of values |Tal)le fields Type |\Aﬁ(|th |
& Multine [Multine] [ p D courter
f\u'mca [Woice] W Fecodediirel Iiel double
ypager [Pager] fT ultline integer
&Internet [Internet] W “oice integer
& CallerID [CallerID] (> Pager integer
&% SurveyDate [SurveyDate] (> Internet F‘DUWE
@ Comments [Comments] [y CalleriD integer
fT SurveyDate datetime
[T Commments varchar 255

Right-click on a variable for more
informnation
User-Missing Walues

(&) Export as valid values

() Export numeric user-missing values as nulls and export string user-missing values as blank spaces

[ < Back H Mt = ][ Finish ][ Cancel ][ Help ]

B As a general rule, the basic data type (string or numeric) for the variable should match the
basic data type of the database field. If there is a data type mismatch that cannot be resolved
by the database, an error results and no data is exported to the database. For example, if you
export a string variable to a database field with a numeric data type (for example, double,
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real, integer), an error will result if any values of the string variable contain non-numeric
characters. The letter a in the icon next to a variable denotes a string variable.

B You cannot modify the field name, type, or width. The original database field attributes are
preserved; only the values are replaced.

Adding New Fields

To add new fields to an existing database table:

» In the Choose how to export the data panel of the Export to Database Wizard, select Add new
fields to an existing table.

» In the Select a table or view panel, select the database table.

» In the Match cases to records panel, match the variables that uniquely identify each case to the
corresponding database field names.

» Drag and drop the variables that you want to add as new fields to the Source of values column.

Figure 3-31
Export to Database Wizard, adding new fields to an existing table

Export to Database Wizard

Select variables to store in new fields ¥

====58

Ta store a variable in a new field, place it in the Source of values column in the grid. Use the arrow keys or drag and drap. Click
on the new field name, type, or width ko edit it

Match cases to records! ID=SurveysSubset. 1D

SPSS: [SurveySubset] Table: SurveySubset L
yWireless [Wireless] Source of values Table fields Type Width ||
&Multline [1ultline]
f\u'mca [Woice]

&Pager [Pager]

Internet [Internst]
fCallerID [Caller1t]
@SurveyDate [SurveyDate]
@a Comments [Comments]

4 [Recodeditireless Recoded Wireless couhle

< B

Right-click on & variable for more: [¥] Show existing Fields
infarmation

User-Missing Walues
() Export as valid values

() Export numeric user-missing values as nulls and export string user-missing values as blank spaces

< Back H Mt = ][ Finish ][ Cancel ][ Help ]

For information on field names and data types, see the section on creating database fields from
SPSS variables in Exporting to a Database on p. 48.

Show existing fields. Select this option to display a list of existing fields. You cannot use this panel
in the Export to Database Wizard to replace existing fields, but it may be helpful to know what
fields are already present in the table. If you want to replace the values of existing fields, see
Replacing Values in Existing Fields on p. 55.
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Appending New Records (Cases)

To append new records (cases) to a database table:

» In the Choose how to export the data panel of the Export to Database Wizard, select Append new
records to an existing table.

» In the Select a table or view panel, select the database table.

» Match variables in the active dataset to table fields by dragging and dropping variables to the
Source of values column.

Figure 3-32
Export to Database Wizard, adding records (cases) to a table
Export to Database Wizard
Select variables to store in new records B
g

To store the values of a variable in new records, place the variable in the cell next to the field name, Use the arrow buttons or
drag and drop.

SPSS: [SurveySubset] Table: Surveysubset

&Wirglggs Reroded [Recodediireless] |Source of values Table fields Type |Wi(lth |
[4 D o counter 10
[T Wireless Wiireless double 15
W Multline Futtline irteger 10
[{_ Woice oice integer 10
W Pager Pager integer 10
(4 |imternet Internet double 15
(4 |callerD CallerlD integer 10
[4_ SurveyDate SurveyDate datetime 19
[T Comments Comments warchar 253

Right-click on a variable for more
infarmation

User-Missing Walues
(=) Export as valid values

() Export numeric user-missing values as nulls and export string user-missing values as blank spaces

< Back ” Mext = ” Finish ][ ancel ][ Help

The Export to Database Wizard will automatically select all variables that match existing fields,
based on information about the original database table stored in the active dataset (if available)
and/or variable names that are the same as field names. This initial automatic matching is intended
only as a guide and does not prevent you from changing the way in which variables are matched
with database fields.

When adding new records to an existing table, the following basic rules/limitations apply:

B All cases (or all selected cases) in the active dataset are added to the table. If any of these
cases duplicate existing records in the database, an error may result if a duplicate key value
is encountered. For information on exporting only selected cases, see Selecting Cases to
Export on p. 53.
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B You can use the values of new variables created in the session as the values for existing fields,
but you cannot add new fields or change the names of existing fields. To add new fields to a
database table, see Adding New Fields on p. 56.

B Any excluded database fields or fields not matched to a variable will have no values for the
added records in the database table. (If the Source of values cell is empty, there is no variable
matched to the field.)

Creating a New Table or Replacing a Table

To create a new database table or replace an existing database table:

» In the Choose how to export the data panel of the export wizard, select Drop an existing table and
create a new table of the same name or select Create a new table and enter a name for the new table.

» If you are replacing an existing table, in the Select a table or view panel, select the database table.
» Drag and drop variables into the Variables to save column.

» Optionally, you can designate variables/fields that define the primary key, change field names,
and change the data type.

Figure 3-33
Export to Database Wizard, selecting variables for a new table

Export to Database Wizard

Select variables to store in new table e E=sEE

To save a wariable in a field, place it in the Yariable to Save column. Use the arrow buttons or drag and drop.

Click on the new field name, tvpe, or width to edit, Check the box next to a field to designate it as a primary kev field.

SPSS: [SurveyResponses] Table: Surveysubset

&)Own Tw [CwnTv] |Varial)le to save | !1‘% Field name Type Width |
@ Own YCR, [OwnYCR] (4 D [ caurnter
%Own D Player [OwnCDPlayer] fi_ Wirgless [] [pMireless
&)Own POA [OwnPDA] fq_ Yoice D Yoice double
& Cwn PC [OwnPC] [ 4 [Mutline [ |Muitlirie: double
@ Own Fax [CwnFax] f‘_ Pager [ |Pager double
&)News [Mews] [ 4 |Internet [] |Internet double
&b Respanse [Response] [ 4 calerD ]| caller © dauble

[ 4 |Caltating [ |Callaiting double

3 0
[y 1 d

Right-click on & variable For more
infarmation

User-Missing Walues
(%) Export as valid values

() Export numeric user-missing values as nulls and export string User-missing values as blank spaces

< Back ” [ext = ” Finish ][ Cancel ][ Help

Primary key. To designate variables as the primary key in the database table, select the box in the
column identified with the key icon.

m  All values of the primary key must be unique or an error will result.
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If you select a single variable as the primary key, every record (case) must have a unique
value for that variable.

If you select multiple variables as the primary key, this defines a composite primary key, and
the combination of values for the selected variables must be unique for each case.

For information on field names and data types, see the section on creating database fields from
SPSS variables in Exporting to a Database on p. 48.

Completing the Database Export Wizard

The last panel of the Export to Database Wizard provides a summary that indicates what data will
be exported and how it will be exported. It also gives you the option of either exporting the data or
pasting the underlying command syntax to a syntax window.

Figure 3-34
Export to Database Wizard, finish panel

Export to Database Wizard

Finish EEEEEE

‘our specifications are summarized below. You are ready to export the data or paste the syntax.

Surnimary

Dataset: [SurveyRespanses]
Table: UpdateTable

Cases ko Export: Filtered

Action: Create new kable
User-Missing Walues: Export as walid values

‘what would you like to do?
(®) Export the data

() Paste the syntax

[ Finish |[ Caniel ][ Help

Summary Information

m Dataset. The SPSS session name for the dataset that will be used to export data. This

information is primarily useful if you have multiple open data sources. Data sources opened
using the graphical user interface (for example, the Database Wizard) are automatically
assigned names such as DataSetl, DataSet2, etc. A data source opened using command
syntax will have a dataset name only if one is explicitly assigned.

Table. The name of the table to be modified or created.

Cases to Export. Either all cases are exported or cases selected by a previously defined filter
condition are exported. For more information, see Selecting Cases to Export on p. 53.
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m Action. Indicates how the database will be modified (for example, create a new table, add
fields or records to an existing table).

m  User-Missing Values. User-missing values can be exported as valid values or treated the same
as system-missing for numeric variables and converted to blank spaces for string variables.
This setting is controlled in the panel in which you select the variables to export.

Exporting to Dimensions

The Export to Dimensions dialog box creates an SPSS data file and a Dimensions metadata file
that you can use to read the data into Dimensions applications such as mrinterview and mrTables.
This is particularly useful when “roundtripping” data between SPSS and Dimensions applications.
For example, you can read an mrinterview data source into SPSS, calculate some new variables,
and then save the data in a form that can be read by mrTables, without loss of any of the original
metadata attributes.

To export data for use in Dimensions applications:

» From the menus in the Data Editor window that contains the data you want to export, choose:
File
Export to Dimensions

» Click Data File to specify the name and location of the SPSS data file.

» Click Metadata File to specify the name and location of the Dimensions metadata file.

Figure 3-35
Export to Dimensions dialog box

Export to imensions

Exparting to Dimensions saves the active dataset as an SPSS data file and creates a Dimensions
metadata file,

Data File... c:\tempiDimensionsData. sav
Metadata File. .. C:\templDimensionsData.mdd

If value labels have been defined For any non-missing values of a variable, they must be
@ defined For all non-missing walues of that variable, Otherwise, the unlabeled values wil be
dropped when the data are read by Dimensions,

[ (o] 4 ][ Paste ]’ Reset ]’ Cancel ][ Help

For new variables and datasets not created from Dimensions data sources, SPSS variable attributes
are mapped to Dimensions metadata attributes in the metadata file according to the methods
described in the SPSS SAV DSC documentation in the Dimensions Development Library.
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If the active dataset was created from a Dimensions data source:

®  The new metadata file is created by merging the original metadata attributes with metadata
attributes for any new variables, plus any changes to original variables that might affect their
metadata attributes (for example, addition of, or changes to, value labels).

m  For original variables read from the Dimensions data source, any metadata attributes not
recognized by SPSS are preserved in their original state. For example, SPSS converts grid
variables to regular SPSS variables, but the metadata that defines these grid variables is
preserved when you save the new metadata file.

m [f any Dimensions variables were automatically renamed to conform to SPSS variable naming
rules, the metadata file maps the converted names back to the original Dimensions variable
names.

The presence or absence of value labels can affect the metadata attributes of variables and
consequently the way those variables are read by Dimensions applications. If value labels have
been defined for any nonmissing values of a variable, they should be defined for all nonmissing
values of that variable; otherwise, the unlabeled values will be dropped when the data file is
read by Dimensions.

Protecting Original Data

To prevent the accidental modification or deletion of your original data, you can mark the file as
read-only.

» From the Data Editor menus choose:
File
Mark File Read Only
If you make subsequent modifications to the data and then try to save the data file, you can save
the data only with a different filename, so the original data are not affected.

You can change the file permissions back to read-write by choosing Mark File Read Write
from the File menu.

Virtual Active File

The virtual active file enables you to work with large data files without requiring equally large (or
larger) amounts of temporary disk space. For most analysis and charting procedures, the original
data source is reread each time you run a different procedure. Procedures that modify the data
require a certain amount of temporary disk space to keep track of the changes, and some actions
always require enough disk space for at least one entire copy of the data file.
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Figure 3-36
Temporary disk space requirements
COMPUTE v6 = ...
RECODE v4... SORT CASES BY...
Action GET FILE = 'vi-5.5av". REGRESSION... or
FREQUENCIES... /SAVE ZPRED. CACHE
vi|v2|v3]vd]vs vi | v2 | v3 ]| v4d | v5 | v6 |zpre vi | v2 | v3|v4d ]| v5 | v6 |zpre
11]12]13)14] 15 11]12)13) 1415 )16 ] 1 11 ) 1213141516 ] 1
Virtual 21|22 23| 24 | 25 2122|2324 25] 26 2 2122|2324 25]26] 2
Active 31 (32| 33]34]35 31 [32|33]34]|35]36] 3 31 [32|33[34]35]36] 3
File 41 [ 42| 43| 44| 45 41 {42 43| 44| 45] 46| 4 41 {42 43| 4a]45] 46| 4
51|52 53] 54|55 51 52| 53]|54]|55]56]5 51|52 53]|54]55]56] 5
61|62 63| 64|65 61 |62|63]|64]|65]|66] 6 61 |62|63[64]|65]|66] 6
Data v4  v6 |zpre vi | v2  v3 | v4 | v5 | v6 |zpre
Stored 14| 16 | 1 111213 | 14|15 16| 1
in 24 | 26 | 2 21 (22| 23|24 25] 26| 2
Temporary None 34| 36| 3 31 (32|33[34|35]|36| 3
Disk 44 | 46 | 4 41 [ 42| 43 | 44| 45| 46| 4
Space 54| 56| 5 51| 52| 53| 54|55|56| 5
64 | 66 | 6 61| 62|63 |64/|65|66| 6

Actions that don't require any temporary disk space include:

Reading SPSS data files

Merging two or more SPSS data files

Reading database tables with the Database Wizard
Merging an SPSS data file with a database table

Running procedures that read data (for example, Frequencies, Crosstabs, Explore)

Actions that create one or more columns of data in temporary disk space include:

Computing new variables
Recoding existing variables

Running procedures that create or modify variables (for example, saving predicted values in
Linear Regression)

Actions that create an entire copy of the data file in temporary disk space include:

Reading Excel files

Running procedures that sort data (for example, Sort Cases, Split File)
Reading data with GET TRANSLATE or DATA LIST commands
Using the Cache Data facility or the CACHE command

Launching other applications from SPSS that read the data file (for example, AnswerTree,
DecisionTime)

Note: The GET DATA command provides functionality comparable to DATA LIST without

creating an entire copy of the data file in temporary disk space. The SPLIT FILE command in
command syntax does not sort the data file and therefore does not create a copy of the data file.
This command, however, requires sorted data for proper operation, and the dialog box interface
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for this procedure will automatically sort the data file, resulting in a complete copy of the data file.
(Command syntax is not available with the Student Version.)

Actions that create an entire copy of the data file by default:
m Reading databases with the Database Wizard
B Reading text files with the Text Wizard

The Text Wizard provides an optional setting to automatically cache the data. By default, this
option is selected. You can turn it off by deselecting Cache data locally. For the Database Wizard,
you can paste the generated command syntax and delete the CACHE command.

Creating a Data Cache

Although the virtual active file can vastly reduce the amount of temporary disk space required, the
absence of a temporary copy of the “active” file means that the original data source has to be reread
for each procedure. For large data files read from an external source, creating a temporary copy of
the data may improve performance. For example, for data tables read from a database source, the
SQL query that reads the information from the database must be reexecuted for any command or
procedure that needs to read the data. Since virtually all statistical analysis procedures and charting
procedures need to read the data, the SQL query is reexecuted for each procedure you run, which
can result in a significant increase in processing time if you run a large number of procedures.

If you have sufficient disk space on the computer performing the analysis (either your local
computer or a remote server), you can eliminate multiple SQL queries and improve processing
time by creating a data cache of the active file. The data cache is a temporary copy of the
complete data.

Note: By default, the Database Wizard automatically creates a data cache, but if you use the GET
DATA command in command syntax to read a database, a data cache is not automatically created.
(Command syntax is not available with the Student Version.)

To Create a Data Cache

» From the menus choose:
File
Cache Data...

» Click OK or Cache Now.

OK creates a data cache the next time the program reads the data (for example, the next time you
run a statistical procedure), which is usually what you want because it doesn’t require an extra
data pass. Cache Now creates a data cache immediately, which shouldn’t be necessary under most
circumstances. Cache Now is useful primarily for two reasons:

m A data source is “locked” and can’t be updated by anyone until you end your session, open
a different data source, or cache the data.

m  For large data sources, scrolling through the contents of the Data View tab in the Data Editor
will be much faster if you cache the data.
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To Cache Data Automatically

You can use the SET command to automatically create a data cache after a specified number of
changes in the active data file. By default, the active data file is automatically cached after 20
changes in the active data file.

» From the menus choose:
File
New
Syntax

» In the syntax window, type SET CACHE n (where n represents the number of changes in the
active data file before the data file is cached).

» From the menus in the syntax window choose:
Run
All

Note: The cache setting is not persistent across sessions. Each time you start a new session, the
value is reset to the default of 20.
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Distributed Analysis Mode

Distributed analysis mode allows you to use a computer other than your local (or desktop)
computer for memory-intensive work. Because remote servers that are used for distributed
analysis are typically more powerful and faster than your local computer, distributed analysis
mode can significantly reduce computer processing time. Distributed analysis with a remote
server can be useful if your work involves:

m Large data files, particularly data read from database sources.

B Memory-intensive tasks. Any task that takes a long time in local analysis mode may be
a good candidate for distributed analysis.

Distributed analysis affects only data-related tasks, such as reading data, transforming data,
computing new variables, and calculating statistics. Distributed analysis has no effect on tasks
related to editing output, such as manipulating pivot tables or modifying charts.

Note: Distributed analysis is available only if you have both a local version and access to a
licensed server version of the software that is installed on a remote server. Furthermore, distributed
analysis is available only for Windows desktop computers. It is not available for Mac and Linux.

Server Login

The Server Login dialog box allows you to select the computer that processes commands and runs
procedures. You can select your local computer or a remote server.

65
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Figure 4-1
Server Login dialog box

£ Server Login: Local Computer

Defautt | Server Mame | Description Port |

|v]  |Local Computer

|:| MetworkServer Metwark Server 3016

5 h...
Checkmark indicates start-up connection Sare

| Ok J | Cancel | | Help |

You can add, modify, or delete remote servers in the list. Remote servers usually require a user
ID and password, and a domain name may also be necessary. Contact your system administrator
for information about available servers, a user ID and password, domain names, and other
connection information.

You can select a default server and save the user ID, domain name, and password that are
associated with any server. You are automatically connected to the default server when you
start a new session.

If you are licensed to use the SPSS Adaptor for Predictive Enterprise Services and your site is
running SPSS Predictive Enterprise Services 3.5 or later, you can click Search... to view a list of
servers that are available on your network. If you are not logged on to a Predictive Enterprise
Repository, you will be prompted to enter connection information before you can view the list
of servers.

Adding and Editing Server Login Settings

Use the Server Login Settings dialog box to add or edit connection information for remote servers
for use in distributed analysis mode.
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Figure 4-2
Server Login Settings dialog box

Server Login Settings

Server Name: | MetwarkServer
Port Mumber: | 3013

D'escription: Metwark, Server

Advanced Contection Settings

ok ] [ cancel | [ Hep |

Contact your system administrator for a list of available servers, port numbers for the servers, and
additional connection information. Do not use the Secure Socket Layer unless instructed to do
so by your administrator.

Server Name. A server “name” can be an alphanumeric name that is assigned to a computer (for
example, NetworkServer) or a unique IP address that is assigned to a computer (for example,
202.123.456.78).

Port Number. The port number is the port that the server software uses for communications.
Description. You can enter an optional description to display in the servers list.

Connect with Secure Socket Layer. Secure Socket Layer (SSL) encrypts requests for distributed
analysis when they are sent to the remote SPSS server. Before you use SSL, check with your
administrator. For this option to be enabled, SSL. must be configured on your desktop computer
and the server.

To Select, Switch, or Add Servers

>

From the menus choose:
File

Switch Server...
To select a default server:

In the server list, select the box next to the server that you want to use.

Enter the user ID, domain name, and password that were provided by your administrator.
Note: You are automatically connected to the default server when you start a new session.
To switch to another server:

Select the server from the list.

Enter your user ID, domain name, and password (if necessary).

Note: When you switch servers during a session, all open windows are closed. You will be
prompted to save changes before the windows are closed.
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To add a server:

» Get the server connection information from your administrator.

» Click Add to open the Server Login Settings dialog box.

» Enter the connection information and optional settings, and then click OK.
To edit a server:

» Get the revised connection information from your administrator.

» Click Edit to open the Server Login Settings dialog box.

» Enter the changes and click OK.

To search for available servers:

Note: The ability to search for available servers is available only if you are licensed to use
the SPSS Adaptor for Predictive Enterprise Services and your site is running SPSS Predictive
Enterprise Services 3.5 or later.

» Click Search... to open the Search for Servers dialog box. If you are not logged on to a Predictive
Enterprise Repository, you will be prompted for connection information.

» Select one or more available servers and click OK. The servers will now appear in the Server
Login dialog box.

» To connect to one of the servers, follow the instructions “To switch to another server.”

Searching for Available Servers

Use the Search for Servers dialog box to select one or more servers that are available on your
network. This dialog box appears when you click Search... on the Server Login dialog box.

Figure 4-3
Search for Servers dialog box

< Search for Servers
Server Name | Description Port
10.11 40.216 SPSS Server on Linux 3333
10.11.10.201 SPSS Server on Solaris 3353
10.10.72.68 SPSS Server on windows 32 hit 3016
10.11.10.42 SPSS Server on HP-UX 3333
| Cancel | | Help |

Select one or more servers and click OK to add them to the Server Login dialog box. Although
you can manually add servers in the Server Login dialog box, searching for available servers
lets you connect to servers without requiring that you know the correct server name and port
number. This information is automatically provided. However, you still need the correct logon
information, such as user name, domain, and password.
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Opening Data Files from a Remote Server

In distributed analysis mode, the Open Remote File dialog box replaces the standard Open File
dialog box.

m  The contents of the list of available files, folders, and drives depends on what is available on
or from the remote server. The current server name is indicated at the top of the dialog box.

®m In distributed analysis mode, you will not have access to files on your local computer unless
you specify the drive as a shared device or specify the folders containing your data files as
shared folders. Consult the documentation for your operating system for information on how
to “share” folders on your local computer with the server network.

m [f the server is running a different operating system (for example, you are running Windows
and the server is running UNIX), you probably won’t have access to local data files in
distributed analysis mode even if they are in shared folders.

File Access in Local and Distributed Analysis Mode

The view of data folders (directories) and drives for both your local computer and the
network is based on the computer that you are currently using to process commands and run
procedures—which is not necessarily the computer in front of you.

Local analysis mode. When you use your local computer as your “server,” the view of data files,
folders, and drives in the file access dialog box (for opening data files) is similar to what you see
in other applications or in Windows Explorer. You can see all of the data files and folders on your
computer and any files and folders on mounted network drives.

Distributed analysis mode. When you use another computer as a “remote server” to run commands
and procedures, the view of data files, folders, and drives represents the view from the remote
server computer. Although you may see familiar folder names (such as Program Files) and drives
(such as C), these items are not the folders and drives on your computer; they are the folders and
drives on the remote server.
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Figure 4-4
Local and remote views
Local View
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In distributed analysis mode, you will not have access to data files on your local computer unless
you specify the drive as a shared device or specify the folders containing your data files as shared
folders. If the server is running a different operating system (for example, you are running
Windows and the server is running UNIX), you probably won’t have access to local data files

in distributed analysis mode even if they are in shared folders.

Distributed analysis mode is not the same as accessing data files that reside on another
computer on your network. You can access data files on other network devices in local analysis
mode or in distributed analysis mode. In local mode, you access other devices from your local
computer. In distributed mode, you access other network devices from the remote server.

If you’re not sure if you’re using local analysis mode or distributed analysis mode, look at the
title bar in the dialog box for accessing data files. If the title of the dialog box contains the word
Remote (as in Open Remote File), or if the text Remote Server: [server name] appears at the top of
the dialog box, you’re using distributed analysis mode.

Note: This situation affects only dialog boxes for accessing data files (for example, Open Data,
Save Data, Open Database, and Apply Data Dictionary). For all other file types (for example,
Viewer files, syntax files, and script files), the local view is always used.

Availability of Procedures in Distributed Analysis Mode

In distributed analysis mode, procedures are available for use only if they are installed on both
your local version and the version on the remote server.

If you have optional components installed locally that are not available on the remote server
and you switch from your local computer to a remote server, the affected procedures will be
removed from the menus and the corresponding command syntax will result in errors. Switching
back to local mode will restore all affected procedures.
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Absolute versus Relative Path Specifications

In distributed analysis mode, relative path specifications for data files and command syntax files
are relative to the current server, not relative to your local computer. A relative path specification
such as /mydocs/mydata.sav does not point to a directory and file on your local drive; it points to a
directory and file on the remote server’s hard drive.

Windows UNC Path Specifications

If you are using a Windows server version, you can use universal naming convention (UNC)
specifications when accessing data and syntax files with command syntax. The general form
of a UNC specification is:

\\servername\sharename\path\filename

B Servername is the name of the computer that contains the data file.

B Sharename is the folder (directory) on that computer that is designated as a shared folder.
B Path is any additional folder (subdirectory) path below the shared folder.

B Filename is the name of the data file.

An example is as follows:

GET FILE='\\hgdev00l\public\july\sales.sav'.

If the computer does not have a name assigned to it, you can use its IP address, as in:
GET FILE='\\204.125.125.53\public\july\sales.sav'.

Even with UNC path specifications, you can access data and syntax files only from devices and
folders that are designated as shared. When you use distributed analysis mode, this situation
includes data and syntax files on your local computer.

UNIX Absolute Path Specifications

For UNIX server versions, there is no equivalent to the UNC path, and all directory paths must
be absolute paths that start at the root of the server; relative paths are not allowed. For example,
if the data file is located in /bin/spss/data and the current directory is also /bin/spss/data, GET
FILE='sales.sav' is not valid; you must specify the entire path, as in:

GET FILE='/bin/spss/sales.sav'.
INSERT FILE='/bin/spss/salesjob.sps'.



Data Editor

Chapter

The Data Editor provides a convenient, spreadsheet-like method for creating and editing data files.
The Data Editor window opens automatically when you start a session.

The Data Editor provides two views of your data:

m Data View. This view displays the actual data values or defined value labels.

m  Variable View. This view displays variable definition information, including defined variable
and value labels, data type (for example, string, date, or numeric), measurement level
(nominal, ordinal, or scale), and user-defined missing values.

In both views, you can add, change, and delete information that is contained in the data file.

Data View
Figure 5-1
Data View
demo.sav - Data Editor =]
Flle Edit “iew Data Transform  Analyee Graphs  Utliies  Add-ons  Window  Help
20 : age 40
age | marital | address | income | inccat | car a
1 55 Married 12 7200| %50 - §74 36—
2 56| Unmarried 28 153.00 e+ 76.
3 28 Married 9 28.00| F25 - §49 13.
4 24 Married 4 26.00| F25 - §49 12.
4 25| Unmarried 2 23.00| Under §25 11.
3 45 Married 9 76.00 e+ 37.
7 42 Unmarried 19 40.00| F25 - §49 19.
g 35| Unmarried 15 57.00| %50 - §74 28.
9 46| Unmarried 2B 24.00| Under §25 12.
10 34 Married 0 §9.00 e+ 46.
11 5 Married 17 72000 %50 - §74 35 ¥
4/ v \Data View /?\Jariame view /| ]< >

Many of the features of Data View are similar to the features that are found in spreadsheet
applications. There are, however, several important distinctions:

m  Rows are cases. Each row represents a case or an observation. For example, each individual
respondent to a questionnaire is a case.

m  Columns are variables. Each column represents a variable or characteristic that is being
measured. For example, each item on a questionnaire is a variable.
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Cells contain values. Each cell contains a single value of a variable for a case. The cell is
where the case and the variable intersect. Cells contain only data values. Unlike spreadsheet
programs, cells in the Data Editor cannot contain formulas.

The data file is rectangular. The dimensions of the data file are determined by the number
of cases and variables. You can enter data in any cell. If you enter data in a cell outside
the boundaries of the defined data file, the data rectangle is extended to include any rows
and/or columns between that cell and the file boundaries. There are no “empty” cells within
the boundaries of the data file. For numeric variables, blank cells are converted to the
system-missing value. For string variables, a blank is considered a valid value.

Variable View

Figure 5-2
Variable View

demo.sav - Data Editor =&
File Edit “ew Data Transform Analyze Graphs  Utlities Add-ons  Window Help
Mame | Type | Width | Decimals Label | “alug [
1|age MNumeric 4 0 Age in years  |Mone
2| marital MNumeric 4 0 Marital status {0, Unmar
3|addrass Mumeric 4 a Years at curre |Mone
4lincome Mumeric g 2 Household inc |Mone
5linceat MNumeric 8 2 Income catego|{1.00, Une
G| car Mumeric 8 2 Price of primar |Maone
7| carcat Mumeric 8 2 Primary vehicl [{1.00, Ect
8| ed Mumeric 4 0 Level of educat|/{1, Did no
9l employ Mumeric 4 0 Years with currMaone
10| retire Mumeric 4 0 Retired {0, Ma}...
11 |empcat Mumeric 4 0 Years with curr{1, Less t
12|jobsat Mumeric 4 0 Job satisfactio {1, Highly
13| gender String 2 0 Gender if, Fernale
14(reside Mumeric 4 0 Mumber of pea |Maone
15|wireless Mumeric 4 0 YWireless serv {0, Mol
16| multline Mumeric 4 0 hultiple lines {0, Mal...
«» '\ Data View )Variable View / ) B e
SPSS Processar is ready

Variable View contains descriptions of the attributes of each variable in the data file. In Variable
View:

Rows are variables.

Columns are variable attributes.

You can add or delete variables and modify attributes of variables, including the following
attributes:

Variable name

Data type

Number of digits or characters
Number of decimal places

Descriptive variable and value labels
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m  User-defined missing values

®  Column width

Measurement level

All of these attributes are saved when you save the data file.

In addition to defining variable properties in Variable View, there are two other methods for
defining variable properties:

The Copy Data Properties Wizard provides the ability to use an external SPSS data file or
another dataset that is available in the current session as a template for defining file and
variable properties in the active dataset. You can also use variables in the active dataset as
templates for other variables in the active dataset. Copy Data Properties is available on
the Data menu in the Data Editor window.

Define Variable Properties (also available on the Data menu in the Data Editor window) scans
your data and lists all unique data values for any selected variables, identifies unlabeled
values, and provides an auto-label feature. This method is particularly useful for categorical
variables that use numeric codes to represent categories—for example, 0 = Male, 1 = Female.

To Display or Define Variable Attributes

» Make the Data Editor the active window.

» Double-click a variable name at the top of the column in Data View, or click the Variable View tab.

» To define new variables, enter a variable name in any blank row.

» Select the attribute(s) that you want to define or modify.

Variable Names

The following rules apply to variable names:

Each variable name must be unique; duplication is not allowed.

Variable names can be up to 64 bytes long, and the first character must be a letter or one of
the characters @, #, or $. Subsequent characters can be any combination of letters, numbers,
nonpunctuation characters, and a period (.). In code page mode, sixty-four bytes typically
means 64 characters in single-byte languages (for example, English, French, German,
Spanish, Italian, Hebrew, Russian, Greek, Arabic, and Thai) and 32 characters in double-byte
languages (for example, Japanese, Chinese, and Korean). Many string characters that only
take one byte in code page mode take two or more bytes in Unicode mode. For example, ¢ is
one byte in code page format but is two bytes in Unicode format; so résumé is six bytes in a
code page file and eight bytes in Unicode mode.

Note: Letters include any nonpunctuation characters used in writing ordinary words in the
languages supported in the platform’s character set.

Variable names cannot contain spaces.
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A # character in the first position of a variable name defines a scratch variable. You can only
create scratch variables with command syntax. You cannot specify a # as the first character of
a variable in dialog boxes that create new variables.

A § sign in the first position indicates that the variable is a system variable. The $ sign is not
allowed as the initial character of a user-defined variable.

The period, the underscore, and the characters $, #, and @ can be used within variable names.
For example, 4. $@#! is a valid variable name.

Variable names ending with a period should be avoided, since the period may be interpreted
as a command terminator. You can only create variables that end with a period in command
syntax. You cannot create variables that end with a period in dialog boxes that create new
variables.

Variable names ending in underscores should be avoided, since such names may conflict with
names of variables automatically created by commands and procedures.

Reserved keywords cannot be used as variable names. Reserved keywords are ALL, AND,
BY, EQ, GE, GT, LE, LT, NE, NOT, OR, TO, and WITH.

Variable names can be defined with any mixture of uppercase and lowercase characters,
and case is preserved for display purposes.

When long variable names need to wrap onto multiple lines in output, lines are broken at
underscores, periods, and points where content changes from lower case to upper case.

Variable Measurement Level

You can specify the level of measurement as scale (numeric data on an interval or ratio scale),
ordinal, or nominal. Nominal and ordinal data can be either string (alphanumeric) or numeric.

Nominal. A variable can be treated as nominal when its values represent categories with no
intrinsic ranking (for example, the department of the company in which an employee works).
Examples of nominal variables include region, zip code, and religious affiliation.

Ordinal. A variable can be treated as ordinal when its values represent categories with some
intrinsic ranking (for example, levels of service satisfaction from highly dissatisfied to
highly satisfied). Examples of ordinal variables include attitude scores representing degree
of satisfaction or confidence and preference rating scores.

Scale. A variable can be treated as scale when its values represent ordered categories with a
meaningful metric, so that distance comparisons between values are appropriate. Examples of
scale variables include age in years and income in thousands of dollars.

Note: For ordinal string variables, the alphabetic order of string values is assumed to reflect the
true order of the categories. For example, for a string variable with the values of low, medium,
high, the order of the categories is interpreted as high, low, medium, which is not the correct order.
In general, it is more reliable to use numeric codes to represent ordinal data.
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New numeric variables created during a session are assigned the scale measurement level. For
data read from external file formats and SPSS data files that were created prior to version 8.0,
default assignment of measurement level is based on the following rules:

B Numeric variables with fewer than 24 unique values and string variables are set to nominal.

B Numeric variables with 24 or more unique values are set to scale.

You can change the scale/nominal cutoff value for numeric variables in the Options dialog box.
For more information, see Data Options in Chapter 45 on p. 457.

The Define Variable Properties dialog box, available from the Data menu, can help you assign
the correct measurement level. For more information, see Assigning the Measurement Level in
Chapter 7 on p. 101.

Variable Type

Variable Type specifies the data type for each variable. By default, all new variables are assumed
to be numeric. You can use Variable Type to change the data type. The contents of the Variable
Type dialog box depend on the selected data type. For some data types, there are text boxes

for width and number of decimals; for other data types, you can simply select a format from a
scrollable list of examples.

Figure 5-3

Variable Type dialog box

& variable Type 4
() Numeric Fast |~
Oe it -
) Comma PO
) Dot g
O scientific notati e E s
A ablentmc notataon $m,m
() Date Bt e A —
& Dol o A
@)
w2 olar A A A -
) Customn currency Witith:
) String Decimal Places: D

| [0]24 _” Cancel || Help |

The available data types are as follows:

Numeric. A variable whose values are numbers. Values are displayed in standard numeric format.
The Data Editor accepts numeric values in standard format or in scientific notation.

Comma. A numeric variable whose values are displayed with commas delimiting every three
places and displayed with the period as a decimal delimiter. The Data Editor accepts numeric
values for comma variables with or without commas or in scientific notation. Values cannot
contain commas to the right of the decimal indicator.
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Dot. A numeric variable whose values are displayed with periods delimiting every three places
and with the comma as a decimal delimiter. The Data Editor accepts numeric values for dot
variables with or without periods or in scientific notation. Values cannot contain periods to the
right of the decimal indicator.

Scientific notation. A numeric variable whose values are displayed with an embedded E and a
signed power-of-10 exponent. The Data Editor accepts numeric values for such variables with or
without an exponent. The exponent can be preceded by E or D with an optional sign or by the sign
alone—for example, 123, 1.23E2, 1.23D2, 1.23E+2, and 1.23+2.

Date. A numeric variable whose values are displayed in one of several calendar-date or clock-time
formats. Select a format from the list. You can enter dates with slashes, hyphens, periods,
commas, or blank spaces as delimiters. The century range for two-digit year values is determined
by your Options settings (from the Edit menu, choose Options, and then click the Data tab).

Dollar. A numeric variable displayed with a leading dollar sign ($), commas delimiting every three
places, and a period as the decimal delimiter. You can enter data values with or without the
leading dollar sign.

Custom currency. A numeric variable whose values are displayed in one of the custom currency
formats that you have defined on the Currency tab of the Options dialog box. Defined custom
currency characters cannot be used in data entry but are displayed in the Data Editor.

String. A variable whose values are not numeric and therefore are not used in calculations. The
values can contain any characters up to the defined length. Uppercase and lowercase letters are
considered distinct. This type is also known as an alphanumeric variable.

To Define Variable Type
» Click the button in the Type cell for the variable that you want to define.
» Select the data type in the Variable Type dialog box.
» Click OK.

Input versus Display Formats

Depending on the format, the display of values in Data View may differ from the actual value as
entered and stored internally. Following are some general guidelines:

®  For numeric, comma, and dot formats, you can enter values with any number of decimal
positions (up to 16), and the entire value is stored internally. The Data View displays only
the defined number of decimal places and rounds values with more decimals. However, the
complete value is used in all computations.

m  For string variables, all values are right-padded to the maximum width. For a string variable
with a maximum width of three, a value of No is stored internally as 'No ' and is not
equivalent to ' No'.

m  For date formats, you can use slashes, dashes, spaces, commas, or periods as delimiters
between day, month, and year values, and you can enter numbers, three-letter abbreviations,
or complete names for month values. Dates of the general format dd-mmm-yy are displayed
with dashes as delimiters and three-letter abbreviations for the month. Dates of the general
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format dd/mm/yy and mm/dd/yy are displayed with slashes for delimiters and numbers for the
month. Internally, dates are stored as the number of seconds from October 14, 1582. The
century range for dates with two-digit years is determined by your Options settings (from
the Edit menu, choose Options, and then click the Data tab).

m  For time formats, you can use colons, periods, or spaces as delimiters between hours, minutes,
and seconds. Times are displayed with colons as delimiters. Internally, times are stored as a
number of seconds that represents a time interval. For example, 10:00:00 is stored internally
as 36000, which is 60 (seconds per minute) x 60 (minutes per hour) x 10 (hours).

Variable Labels

You can assign descriptive variable labels up to 256 characters (128 characters in double-byte
languages). Variable labels can contain spaces and reserved characters that are not allowed in
variable names.

To Specify Variable Labels
» Make the Data Editor the active window.
» Double-click a variable name at the top of the column in Data View, or click the Variable View tab.

» In the Label cell for the variable, enter the descriptive variable label.

Value Labels

You can assign descriptive value labels for each value of a variable. This process is particularly
useful if your data file uses numeric codes to represent non-numeric categories (for example,
codes of 1 and 2 for male and female).

B Value labels can be up to 120 bytes.

Figure 5-4
Value Labels dialog box
B Value Labels 2
Yalue Lahels
Label: |
F="Femala"
M= "Male"

[o]34 || Cancel || Help




79

Data Editor

To Specify Value Labels

>
>
>
>

Click the button in the Values cell for the variable that you want to define.
For each value, enter the value and a label.
Click Add to enter the value label.

Click OK.

Inserting Line Breaks in Labels

>
>

>

Variable labels and value labels automatically wrap to multiple lines in pivot tables and charts if
the cell or area isn’t wide enough to display the entire label on one line, and you can edit results to
insert manual line breaks if you want the label to wrap at a different point. You can also create
variable labels and value labels that will always wrap at specified points and be displayed on
multiple lines.

For variable labels, select the Label cell for the variable in Variable View in the Data Editor.

For value labels, sclect the Values cell for the variable in Variable View in the Data Editor, click
the button in the cell, and select the label that you want to modify in the Value Labels dialog box.

At the place in the label where you want the label to wrap, type \n.

The \n is not displayed in pivot tables or charts; it is interpreted as a line break character.

Missing Values

Missing Values defines specified data values as user-missing. For example, you might want to
distinguish between data that are missing because a respondent refused to answer and data that are
missing because the question didn’t apply to that respondent. Data values that are specified as
user-missing are flagged for special treatment and are excluded from most calculations.

Figure 5-5
Missing Values dialog box

] Missi ng Values 7

() No missing values
() Discrete missing values

1999 | |

() Range plus one optional discrete missing value

|| (0] 4 ||| Cancel || Help |

B You can enter up to three discrete (individual) missing values, a range of missing values,
or a range plus one discrete value.

B Ranges can be specified only for numeric variables.
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m  All string values, including null or blank values, are considered to be valid unless you
explicitly define them as missing.

®  Missing values for string variables cannot exceed eight bytes. (There is no limit on the defined
width of the string variable, but defined missing values cannot exceed eight bytes.)

m  To define null or blank values as missing for a string variable, enter a single space in one of
the fields under the Discrete missing values selection.

To Define Missing Values

» Click the button in the Missing cell for the variable that you want to define.

» Enter the values or range of values that represent missing data.

Column Width

You can specify a number of characters for the column width. Column widths can also be changed
in Data View by clicking and dragging the column borders.

Column formats affect only the display of values in the Data Editor. Changing the column
width does not change the defined width of a variable.

Variable Alignment

Alignment controls the display of data values and/or value labels in Data View. The default

alignment is right for numeric variables and left for string variables. This setting affects only
the display in Data View.

Applying Variable Definition Attributes to Multiple Variables
After you have defined variable definition attributes for a variable, you can copy one or more
attributes and apply them to one or more variables.

Basic copy and paste operations are used to apply variable definition attributes. You can:

m  Copy a single attribute (for example, value labels) and paste it to the same attribute cell(s)
for one or more variables.

m  Copy all attributes from one variable and paste them to one or more other variables.

m  Create multiple new variables with all the attributes of a copied variable.

Applying Variable Definition Attributes to Other Variables

To Apply Individual Attributes from a Defined Variable

» In Variable View, select the attribute cell that you want to apply to other variables.

» From the menus choose:
Edit
Copy
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Select the attribute cell(s) to which you want to apply the attribute. (You can select multiple
target variables.)

From the menus choose:
Edit
Paste

If you paste the attribute to blank rows, new variables are created with default attributes for all
attributes except the selected attribute.

To Apply All Attributes from a Defined Variable

In Variable View, select the row number for the variable with the attributes that you want to
use. (The entire row is highlighted.)

From the menus choose:
Edit
Copy

Select the row number(s) for the variable(s) to which you want to apply the attributes. (You
can select multiple target variables.)

From the menus choose:

Edit
Paste

Generating Multiple New Variables with the Same Attributes

>

In Variable View, click the row number for the variable that has the attributes that you want to use
for the new variable. (The entire row is highlighted.)

From the menus choose:
Edit
Copy
Click the empty row number beneath the last defined variable in the data file.

From the menus choose:
Edit

Paste Variables...
In the Paste Variables dialog box, enter the number of variables that you want to create.

Enter a prefix and starting number for the new variables.

Click OK.

The new variable names will consist of the specified prefix plus a sequential number starting
with the specified number.
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Custom Variable Attributes

In addition to the standard variable attributes (for example, value labels, missing values,
measurement level), you can create your own custom variable attributes. Like standard variable
attributes, these custom attributes are saved with SPSS-format data files. Therefore, you could
create a variable attribute that identifies the type of response for survey questions (for example,
single selection, multiple selection, fill-in-the-blank) or the formulas used for computed variables.

Creating Custom Variable Attributes

To create new custom attributes:

In Variable View, from the menus choose:

Data
New Custom Attribute...

Drag and drop the variables to which you want to assign the new attribute to the Selected
Variables list.

Enter a name for the attribute. Attribute names must follow the same rules as variable names. For
more information, see Variable Names on p. 74.

Enter an optional value for the attribute. If you select multiple variables, the value is assigned
to all selected variables. You can leave this blank and then enter values for each variable in
Variable View.

Figure 5-6
New Custom Attribute dialog box

Mew Custom Attribute

Select variable(s) For the new custom attribute.
wariables: Selected variables:

& hge [Age] & dwalncome [Avglncome]
&)Gender [Gender]

flncomel [Incame1]
flncomﬂ [IncomeZ]
@ﬁlncomeS [Income3] 4
&)OwnHome [OwnHome]

&)MortgageType [Martg...
&Maxlncome [MaxIncome]

Use Chrl-a bo select all variables in the list,

Attribute name: Formula

Attribute value: MeaniIncomel, IncomeZ, Income3)

Display attribute in the Data Editor

[ Display Defined List of Attributes == ]

[ ok |[ Cancel “ Help
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Display attribute in the Data Editor. Displays the attribute in Variable View of the Data Editor. For
information on controlling the display of custom attributes, see Displaying and Editing Custom
Variable Attributes below.

Display Defined List of Attributes. Displays a list of custom attributes already defined for the dataset.
Attribute names that begin with a dollar sign ($) are reserved attributes that cannot be modified.

Displaying and Editing Custom Variable Attributes

Custom variable attributes can be displayed and edited in the Data Editor in Variable View.

Figure 5-7
Custom variable attributes displayed in Variable View
R *Untitled3 [] - Data Editor ===
File Edit Wiew Data Transform Analyze Graphs  Utlities  Add-ons  Window Help
[AnswerFarmat] | [DerivedFrarm] | [Formula] | [Motes] *
1|Fill-in Ernpity L
2[Single select Ernpity [
3[Fill-in Ernpity
4[Fill-in Empity
a[Fill-in Empty
G[Single select Empty
7| Single select Empty
8|Computed value  |Aray . mean(incomel, Income2, Income3) | Ermpiy
A Computed value  |Aray. . max(lncomel, Income2, Income3) | Ermply
10
11
12 v
4+ |\ Data View }Variable View f |<] uw_| [2]

Custom variable attribute names are enclosed in square brackets.
Attribute names that begin with a dollar sign are reserved and cannot be modified.

A blank cell indicates that the attribute does not exist for that variable; the text Empty
displayed in a cell indicates that the attribute exists for that variable but no value has been
assigned to the attribute for that variable. Once you enter text in the cell, the attribute exists
for that variable with the value you enter.

B The text Array... displayed in a cell indicates that this is an attribute array—an attribute that
contains multiple values. Click the button in the cell to display the list of values.

To Display and Edit Custom Variable Attributes

» In Variable View, from the menus choose:
View
Customize Variable View...

» Select (check) the custom variable attributes you want to display. (The custom variable attributes
are the ones enclosed in square brackets.)
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Figure 5-8
Customize Variable View
ﬁ Customize Variabhle View
Reorder and select attributes to display in the “Yariakle Yiew
Shioey | Mame

narme
type
wickh
decimals

label

values
missing
calumns

FEEEEREEEEEEEEE

align
measure
[&nswerFormat]
[DerivedFram]
[Formula]
[Metes]
Restare Detfaults:
[ [9]L4 _” Cancel H Help ]

Once the attributes are displayed in Variable View, you can edit them directly in the Data Editor.

Variable Attribute Arrays

The text Array... (displayed in a cell for a custom variable attribute in Variable View or in the
Custom Variable Properties dialog box in Define Variable Properties) indicates that this is an
attribute array, an attribute that contains multiple values. For example, you could have an
attribute array that identifies all of the source variables used to compute a derived variable. Click
the button in the cell to display and edit the list of values.

Figure 5-9
Custom Attribute Array dialog box

Custom Attribute: Array

Array: DerivedFrom

1 Incomel Add
Z  Incomed
3 Incomes

QF ][ Cancel ][ Help

Customizing Variable View

You can use Customize Variable View to control which attributes are displayed in Variable View
(for example, name, type, label) and the order in which they are displayed.
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Any custom variable attributes associated with the dataset are enclosed in square brackets. For

more information, see Creating Custom Variable Attributes on p. 82.

Customized display settings are saved with SPSS-format data files.

You can also control the default display and order of attributes in Variable View. For more
information, see Changing the Default Variable View in Chapter 45 on p. 458.

To Customize Variable View

» In Variable View, from the menus choose:

View

Customize Variable View...

>

Select (check) the variable attributes you want to display.

» Use the up and down arrow buttons to change the display order of the attributes.

Figure 5-

10

Customize Variable View dialog box

ﬁ Customize Variabhle View

Reorder and select attributes to display in the “Yariakle Yiew

Shioey |

Mame

FEEEEREEEEEEEEE

type

niame

widdth
decimals

label

values
missing
calumns

align

measure
[&nswerFormat]
[DerivedFram]
[Formula]
[Metes]

Restare Detfaults:

[

ok _” cancel H Help ]

Restore Defaults. Apply the default display and order settings.

Spell Checking Variable and Value Labels

To check the spelling of variable labels and value labels:

» In Variable View, right-click on the Labels or Values column and from the context menu choose:

Spelling

or

» In Variable View, from the menus choose:

Utilities
Spelling



86

Chapter 5

or

» In the Value Labels dialog box, click Spelling. (This limits the spell checking to the value labels
for a particular variable.)

Spell checking is limited to variable labels and value labels in Variable View of the Data Editor.

Entering Data

In Data View, you can enter data directly in the Data Editor. You can enter data in any order. You
can enter data by case or by variable, for selected areas or for individual cells.

m  The active cell is highlighted.

®  The variable name and row number of the active cell are displayed in the top left corner
of the Data Editor.

®  When you select a cell and enter a data value, the value is displayed in the cell editor at
the top of the Data Editor.

m Data values are not recorded until you press Enter or select another cell.

m  To enter anything other than simple numeric data, you must define the variable type first.

If you enter a value in an empty column, the Data Editor automatically creates a new variable
and assigns a variable name.

To Enter Numeric Data
» Select a cell in Data View.
» Enter the data value. (The value is displayed in the cell editor at the top of the Data Editor.)

» To record the value, press Enter or select another cell.

To Enter Non-Numeric Data
» Double-click a variable name at the top of the column in Data View or click the Variable View tab.
Click the button in the Type cell for the variable.
Select the data type in the Variable Type dialog box.
Click OK.

Double-click the row number or click the Data View tab.

vV v v v Vv

Enter the data in the column for the newly defined variable.

To Use Value Labels for Data Entry

» If value labels aren’t currently displayed in Data View, from the menus choose:
View
Value Labels
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» Click the cell in which you want to enter the value.

» Choose a value label from the drop-down list.
The value is entered, and the value label is displayed in the cell.

Note: This process works only if you have defined value labels for the variable.

Data Value Restrictions in the Data Editor

The defined variable type and width determine the type of value that can be entered in the cell in
Data View.

B If you type a character that is not allowed by the defined variable type, the character is not
entered.

For string variables, characters beyond the defined width are not allowed.

For numeric variables, integer values that exceed the defined width can be entered, but the
Data Editor displays either scientific notation or a portion of the value followed by an ellipsis
(...) to indicate that the value is wider than the defined width. To display the value in the
cell, change the defined width of the variable.

Note: Changing the column width does not affect the variable width.

Editing Data

With the Data Editor, you can modify data values in Data View in many ways. You can:
m  Change data values

Cut, copy, and paste data values

Add and delete cases

Add and delete variables

Change the order of variables

Replacing or Modifying Data Values

To Delete the Old Value and Enter a New Value
» In Data View, double-click the cell. (The cell value is displayed in the cell editor.)
» Edit the value directly in the cell or in the cell editor.

» Press Enter or select another cell to record the new value.

Cutting, Copying, and Pasting Data Values

You can cut, copy, and paste individual cell values or groups of values in the Data Editor. You can:

®  Move or copy a single cell value to another cell

®  Move or copy a single cell value to a group of cells
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®  Move or copy the values for a single case (row) to multiple cases
m  Move or copy the values for a single variable (column) to multiple variables

m  Move or copy a group of cell values to another group of cells

Data Conversion for Pasted Values in the Data Editor

If the defined variable types of the source and target cells are not the same, the Data Editor
attempts to convert the value. If no conversion is possible, the system-missing value is inserted in
the target cell.

Converting numeric or date into string. Numeric (for example, numeric, dollar, dot, or comma) and
date formats are converted to strings if they are pasted into a string variable cell. The string
value is the numeric value as displayed in the cell. For example, for a dollar format variable, the
displayed dollar sign becomes part of the string value. Values that exceed the defined string
variable width are truncated.

Converting string into numeric or date. String values that contain acceptable characters for the
numeric or date format of the target cell are converted to the equivalent numeric or date value. For
example, a string value of 25/12/91 is converted to a valid date if the format type of the target cell
is one of the day-month-year formats, but the value is converted to system-missing if the format
type of the target cell is one of the month-day-year formats.

Converting date into numeric. Date and time values are converted to a number of seconds if the
target cell is one of the numeric formats (for example, numeric, dollar, dot, or comma). Because
dates are stored internally as the number of seconds since October 14, 1582, converting dates to
numeric values can yield some extremely large numbers. For example, the date 10/29/91 is
converted to a numeric value of 12,908,073,600.

Converting numeric into date or time. Numeric values are converted to dates or times if the value
represents a number of seconds that can produce a valid date or time. For dates, numeric values
that are less than 86,400 are converted to the system-missing value.

Inserting New Cases

Entering data in a cell in a blank row automatically creates a new case. The Data Editor inserts the
system-missing value for all other variables for that case. If there are any blank rows between the
new case and the existing cases, the blank rows become new cases with the system-missing value
for all variables. You can also insert new cases between existing cases.

To Insert New Cases between Existing Cases

» In Data View, select any cell in the case (row) below the position where you want to insert the
new case.

» From the menus choose:

Edit
Insert Cases

A new row is inserted for the case, and all variables receive the system-missing value.
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Inserting New Variables

Entering data in an empty column in Data View or in an empty row in Variable View automatically
creates a new variable with a default variable name (the prefix var and a sequential number)

and a default data format type (numeric). The Data Editor inserts the system-missing value for
all cases for the new variable. If there are any empty columns in Data View or empty rows in
Variable View between the new variable and the existing variables, these rows or columns also
become new variables with the system-missing value for all cases. You can also insert new
variables between existing variables.

To Insert New Variables between Existing Variables

» Select any cell in the variable to the right of (Data View) or below (Variable View) the position
where you want to insert the new variable.

» From the menus choose:
Edit
Insert Variable

A new variable is inserted with the system-missing value for all cases.

To Move Variables

» To select the variable, click the variable name in Data View or the row number for the variable in
Variable View.

» Drag and drop the variable to the new location.

» If you want to place the variable between two existing variables: In Data View, drop the variable
on the variable column to the right of where you want to place the variable, or in Variable View,
drop the variable on the variable row below where you want to place the variable.

To Change Data Type

You can change the data type for a variable at any time by using the Variable Type dialog box

in Variable View. The Data Editor will attempt to convert existing values to the new type. If no
conversion is possible, the system-missing value is assigned. The conversion rules are the same as
the rules for pasting data values to a variable with a different format type. If the change in data
format may result in the loss of missing-value specifications or value labels, the Data Editor
displays an alert box and asks whether you want to proceed with the change or cancel it.

Finding Cases or Variables

The Go To Case/Variable dialog box finds the specified case (row) number or variable name in
the Data Editor.

» From the menus choose:

Edit
Go to Case
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or
Edit
Go to Variable

» For cases, enter an integer value that represents the current row number in Data View.

Note: The current row number for a particular case can change due to sorting and other actions.

or

» For variables, enter the variable name or select the variable from the drop-down list.

Figure 5-11
Go To dialog box

@Gn To

Caze | ‘“ariable

Goto variable:
Age [~]| oo |
(Credit_rating
Aoe |
Income =
:Credit_cards
Education

Car_loans

Finding and Replacing Data and Attribute Values

To find and/or replace data values in Data View or attribute values in Variable View:

» Click a cell in the column you want to search. (Finding and replacing values is restricted to a
single column.)

» From the menus choose:
Edit
Find
or

Edit
Replace

Data View
B You cannot search up in Data View. The search direction is always down.

m  For dates and times, the formatted values as displayed in Data View are searched. For example,
a date displayed as 10/28/2007 will not be found by a search for a date of 10-28-2007.

®  For other numeric variables, Contains, Begins with, and Ends with search formatted values. For
example, with the Begins with option, a search value of $123 for a Dollar format variable will
find both $123.00 and $123.40 but not $1,234. With the Entire cell option, the search value
can be formatted or unformatted (simple F numeric format), but only exact numeric values
(to the precision displayed in the Data Editor) are matched.

m [f value labels are displayed for the selected variable column, the label text is searched, not the
underlying data value, and you cannot replace the label text.
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Variable View

®  Find is only available for the Name, Label, Values, Missing, and custom variable attribute
columns.

B Replace is only available for the Label, Values, and custom attribute columns.

m In the Jalues (value labels) column, the search string can match either the data value or a
value label.

Note: Replacing the data value will delete any previous value label associated with that value.

Case Selection Status in the Data Editor

If you have selected a subset of cases but have not discarded unselected cases, unselected cases
are marked in the Data Editor with a diagonal line (slash) through the row number.

Figure 5-12
Filtered cases in the Data Editor
£ *demo.sav [DataSet2] - Data Editor [|[=)] =
File Edit “ew Data Transform Analvze Graphs  Utlities Add-ons  Window  Help
13 : empcat 1
age | marital | address | income | inccat | car | &
1 18| Unmarried 0 13.00 | Under 525 630 —
7] 18| Unmarried 0 17.00| Under §24 g.60
3 19 Married 0 14.00| Under §25 710
4 19 Married 0 15.00| Under $25 7.20
5 19 Married 0 17.00| Under $25 3.30
f,_f“‘E’ 19 Married 0 14.00| Under $25 7.20
7] 19 Unmarried 0 19.00 Under §25 9.40
3 20| Unmarried 1 14.00| Under $25 .00
g 20 Married 1 17.00| Under $25 a.60
10 20 Married 0 19.00 Under 525 9.40
11 20 Married 0 24.00| Under 525 11.40
20 Married 1 1400 Under 525 .90 ]
1 » \DataView A Variable View [ || >
3P335 Processor is ready

Data Editor Display Options

The View menu provides several display options for the Data Editor:
Fonts. This option controls the font characteristics of the data display.
Grid Lines. This option toggles the display of grid lines.

Value Labels. This option toggles between the display of actual data values and user-defined
descriptive value labels. This option is available only in Data View.
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Using Multiple Views

In Data View, you can create multiple views (panes) by using the splitters that are located below
the horizontal scroll bar and to the right of the vertical scroll bar.

You can also use the Window menu to insert and remove pane splitters. To insert splitters:

» In Data View, from the menus choose:

Window
Split

Splitters are inserted above and to the left of the selected cell.

m  [fthe top left cell is selected, splitters are inserted to divide the current view approximately in
half, both horizontally and vertically.

m [f any cell other than the top cell in the first column is selected, a horizontal pane splitter is
inserted above the selected cell.

m [f any cell other than the first cell in the top row is selected, a vertical pane splitter is inserted
to the left of the selected cell.

Data Editor Printing

A data file is printed as it appears on the screen.

®  The information in the currently displayed view is printed. In Data View, the data are printed.
In Variable View, data definition information is printed.

Grid lines are printed if they are currently displayed in the selected view.

Value labels are printed in Data View if they are currently displayed. Otherwise, the actual
data values are printed.

Use the View menu in the Data Editor window to display or hide grid lines and toggle between
the display of data values and value labels.

To Print Data Editor Contents
» Make the Data Editor the acti